
La 3D libre
avec

Blender 2.6

O
li

v
ie

r 
S

a
ra

ja
H

e
n

ri
 H

e
b

e
is

e
n

B
o

ri
s 

Fa
u

re
t

5e édition
pour Linux, Windows 

et Mac OS X

Blender 2.66a

© Groupe Eyrolles, 2013, ISBN : 978-2-212-12897-0



Table des matières

© Groupe Eyrolles, 2013 V

AVANT-PROPOS............................................................ 1
À qui s’adresse ce livre ? • 2

> Vous êtes un curieux ou un débutant • 3
> Vous êtes déjà un utilisateur confirmé de Blender • 3
> Vous êtes un artiste 3D chevronné • 3

Blender est gratuit… vraiment ? • 3
Remerciements • 4

INTRODUCTION : HISTORIQUE DE BLENDER ....................... 7

1. INSTALLATION DE BLENDER.......................................... 11
Installation sous Windows • 12
Installation sous GNU/Linux • 15
Installation sous Mac OS X • 16
Les préférences de l’utilisateur • 17

Personnalisation de Blender • 17
Thèmes de couleur • 17
Paramètres liés aux périphériques d’entrée • 18

Franciser l’interface • 19
Les modules complémentaires (Add-Ons) • 20

2. PRISE EN MAIN DE BLENDER ........................................ 23
Découverte de l’interface graphique • 25

L’écran d’accueil • 25
Le menu principal • 27
La vue principale • 30
L’éditeur des propriétés (Properties) • 32
Personnaliser l’interface • 34

Partitionner les espaces de travail • 34
Sauvegarder les préférences • 36

La vue 3D • 36

Notions de repères • 36
Naviguer dans l’espace • 37
Gestion des vues • 38
Affichage de la scène • 38
Le curseur • 39
Les menus latéraux masqués • 40

Bases fondamentales • 41
Ajout d’un objet dans la scène • 42
Sélection des objets • 43
Manipulations d’un objet dans la vue 3D • 44

Utilisation des manipulateurs • 45
Utilisation des transformations « directes » • 46
Notions de repère global et de repère local • 46

Édition d’un maillage • 48
Les calques • 50

Sauvegarder votre travail • 50
Charger votre travail • 51
Effectuer le rendu d’une image • 51
Enregistrer une image rendue • 52

3. PREMIER PROJET AVEC BLENDER ...................................55
Préparation de l’espace de travail • 56
Modélisation de la carafe • 57

Tracé du profil de la carafe • 57
Transformer le profil en objet • 61
Améliorer l’aspect de la carafe • 63

Lissage de l’ombrage des facettes • 64
Lissage de la géométrie de la carafe • 65

Modifier le profil • 66
Le bec verseur • 67
Ajout de l’anse • 70



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r 2

.6

© Groupe Eyrolles, 2013VI

Pousser la modélisation : création d’un environnement 
rudimentaire • 74
Mise en couleurs de votre première scène • 81

Appliquer une texture à votre table • 82
Donner à la carafe l’apparence du verre • 84
Des cruchons en porcelaine, pour de légers 
effets de réflexion • 85
Modifier l’arrière-plan et ajuster l’éclairage • 87
Étalonnage des couleurs et rendu final • 91

4. TECHNIQUES DE MODÉLISATION.................................... 97
Modélisation polygonale • 98

Les primitives • 98
Les outils de modélisation de base • 103

Joindre deux maillages • 103
Séparer un maillage pour former deux objets distincts • 104
Extrusion • 105
Objets de révolution : fonction Spin • 107
Profils hélicoïdaux : fonction Screw • 109
Duplication procédurale d’objets : fonctions Duplication 
aux sommets et Duplication aux facettes • 111
Le mode d’édition proportionnelle • 117
Outil d’accrochage (Transform Snap) • 120

Outils de modélisation avancés • 123
Fonctions de base de la modélisation polygonale • 124
Travailler avec les boucles • 130
Fonctions avancées de modélisation • 133

Opérations booléennes • 137
Maillages multirésolutions • 140
Sculpture en 3D • 143

Les outils de sculpture • 145
Les paramètres des brosses • 147
Modéliser un paysage grâce au mode Sculpt • 151
Retopologie dynamique • 154

Courbes et objets textes • 155
Les courbes de Bézier • 155

Les poignées • 156
Opérations sur les courbes • 157

Les surfaces de Bézier • 160
Quelques options propres aux surfaces • 161

Extrusion le long d’un chemin • 163
Courbes de variation (Taper Curves) • 165
Les objets textes • 167

Les métaéléments • 169

Insérer un métaélément dans vos scènes • 170
Comportement général des métaéléments • 171
Comportement individuel des métaéléments • 171

Outils spéciaux de modélisation : les modificateurs • 172
Le modificateur subdivision de surfaces 
(Subdivision Surface) • 174
Le modificateur miroir (Mirror) • 176
Le modificateur décimation (Decimate) • 177
Le modificateur Array (arrangements) • 178
Le modificateur Displace (déplacement) • 179
Le modificateur EdgeSplit (séparation aux arêtes) • 180
Le modificateur lissage (Smooth) • 182
Le modificateur Cast (projection) • 183
Le modificateur Bevel (Chanfrein) • 184
Le modificateur SimpleDeform (Déformation Simple) • 185
Le modificateur Shrinkwrap (rétrécir et emballer) • 186
Le modificateur Solidification (Solidify) • 187
Le modificateur Distorsion (Warp) • 189
Le modificateur Remaillage (Remesh) • 190
Le modificateur Peau (Skin) • 192

5. MATÉRIAUX ET TECHNIQUES D’ILLUMINATION 
AVEC CYCLES ............................................................195
Maîtriser les matériaux avec Cycles • 196

Mise en place de l’espace de travail • 196
Le matériau • 198

Couleurs et nuancier • 199
Les shaders de Cycles • 199
Mise en place d’un shader simple • 204

Les textures • 206
Influence des textures • 207
L’onglet Displacement • 209
Définition du système de plaquage des textures • 210
Les textures de type Image • 211
Les textures procédurales • 213

Les matériaux nodaux • 214
Introduction à l’éditeur de nœuds • 215
Plus loin avec les matériaux nodaux • 219

Les indices matériaux • 222
Le dépliage UV • 223

Peindre la texture avec un outil de dessin externe • 226
Peindre la texture dans une vue 
de type UV/Image Editor • 228
Peindre la texture directement dans la vue 3D • 230



Ta
bl

e 
de

s 
m

at
iè

re
s

© Groupe Eyrolles, 2013 VII

Travailler avec des cartes UV • 231
Plusieurs cartes UV affectant différents canaux • 233

Le shading anisotropique • 234
Mise en place d’un shader anisotrope • 235

Techniques d’illumination • 236
Utilisation des lampes • 236

Quelques notions sur l’illumination globale • 236
Le menu Lamp • 237
Les différentes lampes : présentation et usage • 238
Éclairage d’environnement • 242

6. MATÉRIAUX ET TECHNIQUES D’ILLUMINATION 
AVEC BLENDER ......................................................... 249
Maîtriser les matériaux avec Blender • 250

Le matériau • 251
Le shading et la couleur • 253

Couleurs et nuancier • 253
Shaders diffus • 254
Shaders spéculaires • 256
Les rampes de couleur • 257
Autres paramètres liés aux shaders • 258
Le rendu Tangent • 258
Le rendu Toon • 259
Le rendu de halos • 260

Reflets et transparence • 261
Les options de réflectivité • 262
Les options de transparence • 264

La dispersion subsurfacique (SSS) • 266
L’onglet SSS • 267
Des problèmes avec vos matériaux SSS • 269
Exemple de mise en œuvre du SSS • 269

Les textures • 271
Les canaux de texture • 272
Les textures de type Image • 275
Les textures procédurales • 278
L’usage des masques • 279
Render Baking, ou la sauvegarde du résultat de rendu 
dans une texture UV • 281

Les matériaux volumétriques • 286
Mise en place d’un matériau volumétrique • 286
Utilisation de la texture Voxel Data • 287

L’éditeur de nœuds matériaux • 288
Exemple d’usage des matériaux nodaux : 
mélanger deux matériaux • 291

Outils spéciaux de mise en couleurs : les modificateurs • 292
Le modificateur UV Project (projection UV) • 293

Techniques d’illumination • 294
Utilisation des lampes • 295

Les ombres par le shadow buffering • 295
Les ombres par le raytracing • 297
Réglages des lampes • 298

Les différentes lampes : présentation et usage • 300
La lampe (Lamp) • 301
L’aire lumineuse (Area) • 303
Le Spot • 304
Le soleil (Sun) • 305
L’hémi (Hemi) • 307

Occlusion ambiante par lancé de rayons • 308
Distribution des rayons • 309
Réglages de base • 310

Occlusion ambiante approximative • 313
Réglages de base • 314

7. TECHNIQUES D’ANIMATION FONDAMENTALES................317
Animation le long d’un chemin • 318

Approfondir : utiliser le Vector Blur pour simuler le flou 
de vitesse • 322

Explications sur les paramètres du nœud Vector Blur • 324
Animation linéaire par F-Curves • 324

Changer la frame courante • 325
Insertion de clés d’animation • 327

Insérer d’autres clés d’animation • 328
Utilisation de l’éditeur de courbes • 329

Positionner précisément les points • 329
Régler le comportement des courbes au-delà de leur plage 
de définition • 330

Régler la durée de l’animation • 332
Autres types de F-Curves • 332

F-Curve de type Camera • 332
F-Curve de type Lamp • 333
Autres types de F-Curves ? • 333

Les formes clés (shape keys) • 334
Le DopeSheet • 336

Découverte du DopeSheet • 337
Réalisation de l’animation • 338

Animation de la première clé • 339
Animation de la seconde clé • 339

Déformation d’objets : usage des modificateurs • 340



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r 2

.6

© Groupe Eyrolles, 2013VIII

Déformation imposée par un treillis : 
le modificateur Lattice • 341
Déformation imposée par une courbe : 
le modificateur Curve Deform • 343
Déformation imposée par un crochet : 
le modificateur Hook • 345
Construction dynamique de maillage : 
le modificateur Build • 347
Génération d’ondes : le modificateurWave • 348

Le système de particules • 349
Simulation d’une ébullition • 353

Créer le système de particules • 354
Contrôler l’émission de particules • 355
Établir les propriétés physiques des particules • 355
Établir la détection des obstacles • 357
Paramétrer le rendu des particules • 357

Simulation d’un gazon • 358
L’émetteur de particules • 358
Le champ d’action : Wind • 362
Contrôler le comportement des particules grâce 
au weight painting • 364

Simulation d’une coiffure • 366
Simulation d’un système proies/prédateur 
avec les particules Boids • 370

Description de la scène • 371
Mise en place des systèmes de particules • 371
Jouer la simulation • 374

Conclusion • 375

8. TECHNIQUES D’ANIMATION AVANCÉES......................... 377
La simulation de tissus • 378

La nappe • 378
Fixer une partie de la nappe • 381

Les corps souples • 384
Le flan • 384
La balle en mousse  • 388

Les corps rigides • 390
La simulation de fluides • 394

Les principaux objets fluides : Fluid, Inflow, Outflow • 395
Exemple 1 : chute d’une goutte d’eau • 395
Exemple 2 : flux d’eau continu • 399
Quelques conseils méthodologiques • 403

Plusieurs objets fluides et obstacles ? • 403
Résolution et mémoire • 404

Viscosité et taille réelle du domaine • 404
Recommencer la simulation • 404
Mes objets sont hermétiques ! • 405

La simulation de fumée • 405
Paramétrer le rendu de la fumée • 409

La peinture dynamique • 410
Premières expérimentations • 411
Les paramètres fondamentaux du Pinceau • 413
Les paramètres fondamentaux de la toile • 414

L’animation squelettale • 416
Création d’une armature • 417
Appliquer les déformations de l’armature au modèle • 421

Par la méthode des enveloppes • 422
Par la méthode du Bone Heat Weighting • 424
Par la méthode du weight painting • 426

Compléter l’armature • 428
Cinématique inverse • 429
Blender et les contraintes • 430
Quelques conseils méthodologiques • 432

Degrés de liberté • 432
Limitation des angles de rotation • 432

L’éditeur d’actions non linéaires (NLA Editor) • 433
Création d’une action • 433
Création d’une séquence • 435

Animation avancée à l’aide des modificateurs • 437
Déformation imposée par un maillage : 
le modificateur Mesh Deform • 437
La simulation de surface marine : le modificateur Ocean • 439

Création de la surface de l’océan  • 439
Animation de l’océan  • 441
Création du matériau de l’océan  • 442

Explosion d’un maillage : le modificateur Explode • 444
L’add-on Cell Fracture • 445

Conclusion • 449

9. LE RENDU AVEC BLENDER...........................................451
Quelques mots sur les caméras • 452

La caméra en bref • 452
Le flou de focale • 453

Définir le format de vos œuvres • 455
Dimensions de l’image rendue • 455
Format de l’image rendue • 456

Se préparer à effectuer le rendu • 456
Les options de rendu • 457



Ta
bl

e 
de

s 
m

at
iè

re
s

© Groupe Eyrolles, 2013 IX

Régler correctement le nombre de Samples • 457
Optimiser le calcul des rayons dans la scène • 458

L’anticrénelage • 459
Optimisation des performances de rendu • 459
Enregistrer l’image rendue • 460
Créer des animations • 460

L’éditeur de séquences • 461
Utilisation de l’effet Glow • 462

Les propriétés de l’effet Glow • 463
Insertion d’une transition entre deux séquences • 465

Les calques de rendu (Render Layers) • 468
Les calques de rendu • 468

Les options des masques de rendu • 469
Les passes • 469

L’éditeur de nœuds Composite • 471
Quelques exemples d’usage des nœuds Composite 
et des Render Layers • 475

Mélanger des rendus Cycles et Blender Render • 475
Simulation d’un effet de brume  • 479
Le flou focal grâce au nœud DeFocus • 482

Les nœuds pour l’incrustation d’image • 486
Et les autres nœuds Matte ? • 489

Introduction au tracking vidéo • 492

A. LES RACCOURCIS CLAVIER DE BLENDER ....................... 499
La souris • 501

Manipulations de base • 501
Manipulations courantes • 501
Transformations • 501

Le clavier • 502
Touches de fonction • 502

Les raccourcis clavier • 502
Les touches d’usage général • 503
Les touches utiles en mode Object • 504
Les touches utiles en mode Edit • 505

Les touches utiles en mode Sculpt • 506
Les touches utiles en animation • 507
Les touches utiles pour le dépliage UV • 507
Les touches relatives à l’affichage • 508
Les touches relatives au rendu • 509

B. LES ADD-ONS DE BLENDER.........................................511
3D View • 512
Add Curve • 512
Add Mesh • 513
Animation • 513
Compositing • 514
Development • 514
Game Engine • 514
Import et Import-Export • 514
Material • 515
Mesh • 515
Object • 516
Paint • 517
Render • 517
Rigging • 518
System • 518
UV • 518

C. LES INDICES DE RÉFRACTION.......................................519

D. RESSOURCES WEB .....................................................521
Sites informatifs • 521
Communautés • 522
Ressources et documentation • 522

E. CONTENU DU DVD-ROM ...........................................525
Configuration minimale • 526
Configuration moyenne • 526
Configuration de production • 526

INDEX ......................................................................529



© Groupe Eyrolles, 2013

Ce livre possède un format un peu particulier, situé quelque part entre le
manuel d’utilisation et le recueil de didacticiels. Il vise à présenter de façon
synthétique à peu près tout ce qu’il est possible de réaliser avec Blender,
mais aussi à guider pas à pas ceux que les images de synthèse peuvent
effrayer, mais qui voudraient malgré tout tenter leur chance. Malheureuse-
ment, il n’a pas été possible de tout mettre, référencer et présenter (Blender
est un logiciel tellement riche en possibilités !). Aussi parfois, des choix
douloureux ont été effectués avant de figer le contenu d’un chapitre.

Pendant de longues années, j’ai écrit des didacticiels sur l’usage de
Blender (et d’autres logiciels libres d’images de synthèse) et j’ai même eu
l’occasion de collaborer avec l’équipe de rédaction de la documentation
officielle. En effet, la liste des fonctionnalités nouvelles de Blender
s’allongeant très vite, les auteurs habituels n’arrivaient pas à écrire la
documentation à un rythme aussi rapide ; il aurait fallu un temps certain
pour que le retard soit rattrapé sans la bonne volonté d’une poignée de
volontaires. Nous savions que la documentation resterait un chantier
perpétuel, mais c’était manifestement le prix à payer si l’on désirait sou-
tenir un outil en constante évolution. L’écriture de La 3D libre avec
Blender avait donc lentement mûri en moi, mais il fallut une rencontre
opportune et la sortie du livre Gimp 2 efficace de Cédric Gémy (égale-
ment aux éditions Eyrolles) pour concrétiser ce projet latent.

Depuis, la première édition a fait son bonhomme de chemin et a été très
favorablement accueillie par la communauté francophone des utilisateurs
de Blender. J’ai appris avec fierté (et soulagement !), à travers vos nom-
breux et chaleureux courriels, que mes modestes connaissances, accumu-
lées au fil de plusieurs années d’écriture de didacticiels, d’articles et de
bouts de documentation, avaient pu aider à rendre abordable un logiciel
réputé (à tort) comme difficile d’accès. C’est donc naturellement que,

Avant-propos

3DS MAX, MAYA   
Vitesse de développement

Le développement de 3ds Max est réputé très lent,
certains bogues datant de quatre versions anté-
rieures n’étant toujours pas corrigés. En revanche,
dans le passé, le développement de Maya a été
plutôt rapide, mais depuis son rachat par Autodesk
(l’éditeur de 3ds Max), il convient de s’accorder le
temps de juger. Pour sa part, depuis que le code
source de Blender a été racheté par la commu-
nauté et que le logiciel est devenu libre, le déve-
loppement de Blender a été si rapide que
maintenir à jour la documentation est une
gageure.
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porté par ce succès et cet accueil fantastique, cet ouvrage refait son appa-
rition dans une cinquième édition, complètement refondue et enrichie,
pour tenir compte tant des progrès de Blender que de sa richesse en per-
pétuelle expansion.

Et des progrès, Blender en a connu des quantités, ces dernières années :
améliorations relatives à ses outils d’animation et de rendu, adjonction
de divers modules de simulation physique (corps souples, fluides, corps
rigides), etc. Depuis la quatrième édition de cet ouvrage, consacrée à la
version 2.49b, Blender a traversé une phase de restructuration cruciale et
importante, voyant une refonte totale du code de son interface, de ses
appels internes et de son architecture. L’objectif de ce bouleversement ?
Une modularité accrue, pour permettre à Blender de poursuivre son
développement au rythme hallucinant qui est devenu le sien, pour faci-
liter le travail des développeurs et pour favoriser le recrutement de nou-
veaux contributeurs.

Et cette stratégie a été clairement payante si l’on considère toutes les
améliorations qui ont fait leur apparition dans la branche 2.5x (voulue
comme une bêta permanente) et la branche 2.6x (la branche courante, à
laquelle se rapporte cet ouvrage) : nouveau moteur de rendu (Cycles),
outils de sculpture à la pointe du progrès (topologie dynamique), inté-
gration vidéo de qualité quasi professionnelle (tracking vidéo et rotos-
copie), nouvelles capacités de simulation (fumée, flammes, corps rigides,
océans…) et tellement d’autres choses qu’il est impossible de les énu-
mérer succinctement.

Blender se transforme mais il reste égal à lui-même : le couteau suisse de la
3D, toujours plus puissant, plus rapide, plus efficace. Pour mieux vous servir.

À qui s’adresse ce livre ?
Blender a été développé en tant qu’outil de production d’animations 3D.
Il a donc avant tout un usage professionnel et de production. Il est
d’ailleurs étonnant de constater comme Blender devient particulière-
ment efficace lorsque l’on a maîtrisé son fonctionnement général.

Blender n’oublie pas non plus les artistes, en étant très éloigné des outils
de conception ou de dessin assisté par ordinateur, précis mais arides et ne
favorisant pas la créativité personnelle. Au contraire, l’interface de
Blender est vivante, souvent fluctuante même, et semble accompagner
l’utilisateur dans ses travaux, lui permettant de se recentrer sur sa liberté
artistique plutôt que sur la rigueur nécessaire à un réalisme excessif.
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> Vous êtes un curieux ou un débutant
Vous n’avez jamais créé d’images de synthèse et ces mots mêmes vous
paraissent mystérieux ou insurmontables ? Vous trouverez dans cet
ouvrage une excellente introduction à l’imagerie 3D et, au terme de sa
lecture, vous vous sentirez à l’aise et capable de mener, sur la seule base
de votre créativité, vos premiers projets.

> Vous êtes déjà un utilisateur confirmé de Blender
Le développement de Blender va vite, très vite, et souvent, les nou-
veautés ne sont documentées qu’en anglais. Si vous vous sentez dépassé
par le déluge de nouveautés de chaque nouvelle version, ou si vous êtes
fâché avec la langue anglaise, alors cet ouvrage est également fait pour
vous : il reprend toutes les principales fonctionnalités de Blender (des
plus anciennes aux plus récentes) en les démystifiant ou en leur appor-
tant un éclairage particulier. Vous apprécierez alors les cas pratiques qui
parsèment le livre, à décortiquer jusqu’à ce que vous les maîtrisiez.

> Vous êtes un artiste 3D chevronné
Blender mûrit chaque jour. De plus en plus d’artistes accomplis s’y inté-
ressent ou se tournent vers lui. Outre l’avantage d’être gratuit et de béné-
ficier d’un développement dynamique, il s’efforce de se doter des outils
qui font la force des grandes applications commerciales, pour un coût…
nul ! Mais ce qui fait plaisir à lire, ce sont les commentaires d’artistes
confirmés qui s’étonnent de voir, par exemple, dans les forums de
CGTalk (http://forums.cgsociety.org), des images réalisées avec Blender, en
affirmant « [qu’ils ne savaient pas] que Blender était capable de faire
ça ! ». L’autre point de satisfaction, c’est de constater que certains ont
intégré Blender dans leur workflow, que ce soit pour le dépliage UV ou la
simulation des fluides, sans honte d’utiliser un logiciel « gratuit » là où
des confrères dépensent des centaines ou des milliers de dollars pour
aider leur créativité à s’exprimer. Si vous êtes un artiste 3D confirmé et
que vous vous demandez si Blender peut vous aider dans votre démarche
artistique ou professionnelle, ce livre est fait pour vous : il brosse dans ses
grandes lignes la liste des fonctionnalités et capacités de Blender, en les
rapprochant autant que possible de ce qui se fait avec 3ds Max ou Maya,
par exemple, afin de faciliter la transition.

Blender est gratuit… vraiment ?
Oui, vraiment. Vous pouvez le copier à l’envi, le distribuer librement à
tous vos amis, collègues et connaissances. Vous pouvez l’installer sur
autant de postes que souhaité. Vous n’avez aucune limitation, ni sur son

Vous êtes familier d’un autre grand 
logiciel commercial ?

Il serait illusoire d’établir des ponts permanents
entre les divers logiciels commerciaux du marché
et Blender, mais vous trouverez tout au long de cet
ouvrage des apartés expliquant les principales dif-
férences ou similitudes entres les fonctions de
Blender et celles de 3ds Max ou Maya.

3DS MAX   
Langage de script

Le langage de script de 3ds Max lui est propre et
est assez proche du langage C. De son côté,
Blender utilise un langage très répandu, Python,
qui se révèle puissant et flexible.
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usage, ni sur celui des œuvres réalisées avec lui. Et dans le cas où vous
vous sentiriez l’âme d’un développeur, vous pouvez même plonger votre
nez dans les sources du logiciel, voir comment fonctionnent ses arcanes
internes ou détailler les algorithmes employés : c’est la magie du logiciel
libre. Blender est à l’imagerie 3D ce que Gimp est à l’imagerie 2D : un
formidable outil de créativité, riche, puissant, fonctionnel et… totale-
ment gratuit !

D’autres logiciels commerciaux reposent sur quantités de greffons, plug-
ins et extensions, la plupart coûteux et difficiles d’accès, pour produire
des résultats d’une qualité dépendant grandement de la compétence de
l’utilisateur et ce, malgré leur prix. Blender bénéficie pour sa part d’une
communauté de développeurs très actifs et dispose d’une solide base de
scripts Python (des Add-Ons) qui enrichissent ses capacités naturelles.
S’il lui manque une fonctionnalité, il est certain qu’elle est véritablement
inutile ou qu’elle sera intégrée dans une très prochaine version officielle !

Il est temps pour moi de clore cet avant-propos, et pour vous, de plonger
dans la lecture de ce livre qui restera pour longtemps, je l’espère, votre
livre de chevet !

Seysses, février 2013,

Olivier Saraja
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L’ancêtre de Blender est né en 1988 au sein du studio d’animation hol-
landais NeoGeo (l’une des plus grandes sociétés d’animation 3D des
Pays-Bas, primée en 1993 et 1995 par l’European Corporate Video
Awards), société dont Ton Roosendaal fut l’un des cofondateurs. À la
suite d’une intensification des besoins internes, le logiciel fut entière-
ment réécrit et devint la suite de modélisation et d’animation 3D connue
sous le nom de Blender.

En 1998, Ton Roosendaal fonda une nouvelle entité baptisée Not A
Number (NaN) dont l’objectif était de développer et de commercialiser
Blender : l’ambition était d’offrir un outil compact, multi-plates-formes,
professionnel et gratuit, à destination d’un public très large, la société
devant vivre de la vente de produits commerciaux et de services. Blender
fit sensation à la conférence SIGGRAPH de 1999, s’attirant l’attention du
public comme de la presse et confirmant son potentiel hors du commun.

En suscitant le même engouement lors du SIGGRAPH de 2000, NaN
réussit à réunir près de 4 500 000 euros de financement, qui lui permirent
de porter ses effectifs à 50 salariés, aux Pays-Bas, au Japon et aux États-
Unis. Au cours de l’été de la même année, la version 2.0 de Blender, inté-
grant un moteur de jeu, sortait et, à la fin de l’année, Blender pouvait
revendiquer plus de 250 000 utilisateurs enregistrés. Après une réduction
d’effectif due à la frilosité du marché et la recherche de nouveaux investis-
seurs, NaN sortait fin 2001 une mouture commerciale de son logiciel,
Blender Publisher, visant le marché émergeant du contenu interactif pour
les sites web basés sur la 3D. Malheureusement, en raison de ventes déce-
vantes et d’un climat économique de plus en plus difficile, les nouveaux
investisseurs décidèrent de mettre un terme aux activités de NaN, signant
également celui du développement de Blender.

Introduction : 
historique de Blender

3DS MAX, MAYA  
 Portabilité

3ds Max n’est disponible que sur plates-formes
Windows. Pour sa part, Maya a été porté sous
Linux afin de satisfaire aux besoins des studios
Dreamworks. Blender, en revanche, est disponible
sur à peu près toutes les plates-formes existantes
et le portage sur tablettes Android est même en
cours, à titre expérimental !
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Reprendre une nouvelle société avec une base suffisante de développeurs
salariés n’étant économiquement pas envisageable, Ton décida de créer la
Blender Foundation, une fondation à but non lucratif, pour ne pas aban-
donner la communauté enthousiaste d’utilisateurs et de clients qui pleu-
raient la disparition de Blender. En juillet 2002, Ton parvint à
convaincre les investisseurs de NaN de libérer, moyennant finances, les
sources de Blender et lança auprès de la communauté une vaste collecte
de fonds devant rapporter les 100 000 euros qui permettraient de
racheter les droits de propriété intellectuelle et le code source de Blender
aux investisseurs. À la surprise générale, il suffit de seulement sept
semaines à la communauté pour amasser cette somme considérable.
Officiellement, c’est le dimanche 13 octobre 2002 que Blender fut
libéré. Ses fichiers sources furent alors placés sous la licenceGNU GPL
(General Public License).

Depuis, le développement de Blender continue, poussé par des volon-
taires dévoués dispersés sur la planète entière et toujours mené par le
créateur initial de Blender, Ton Roosendaal.
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Premier projet avec Blender

Ce chapitre a pour objet de poser les bases fondamentales 
de la modélisation et de la création de matériaux, en laissant 
pour l’instant de côté la mise en lumière et les réglages relatifs 
au rendu. L’objectif va être ici de modéliser une simple carafe 
au travers de fonctions usuelles mais, surtout, en manipulant 
de façon intensive les raccourcis clavier, qui font toute la force 
de Blender. Nous apprendrons ainsi à déplacer, faire tourner ou 
redimensionner des sélections, à déplacer les points pivots pour 
ces opérations, ou encore à sélectionner des faces, des arêtes ou 
des sommets. Côté matériau, nous allons débuter directement 
par la création du verre, un exercice qui vient très tôt dans 
la carrière de tout artiste numérique qui se respecte, mais 
qui pose également de singuliers problèmes de réalisme. 
Nous verrons également comment tirer profit du moteur 
de rendu en raytracing pour surmonter ces difficultés.

SOMMAIRE

B Modélisation d’une carafe

B Définition d’un matériau 
transparent

MOTS-CLÉS

B Modélisation
B Maillage
B Sommets
B Édition
B Matériau
B Shader
B Verre
B Transparence
B Réflexion
B Raytracing
B Spin
B PET
B Extrude
B Pivot
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Préparation de l’espace de travail
Commencez par lancer Blender. Nous allons préparer notre espace de tra-
vail de façon à être le plus efficace possible. Avec le bouton central de la
souris, cliquez sur le bord séparant la vue 3D principale de la Timeline.
Choisissez Split Area et coupez la vue 3D en deux parties à peu près égales.
De la même façon, toujours avec le bouton central de la souris, cliquez
maintenant sur le bord séparant les deux vues 3D, choisissez à nouveau
Split Area et coupez en deux parties à peu près égales la vue de droite.
Déplacez le curseur de la souris dans la grande vue de gauche et appuyez
sur la touche [1] du pavé numérique : ce sera désormais notre vue de face.
Déplacez le curseur de la souris dans la vue en haut à droite et appuyez sur
la touche [7] du pavé numérique : ce sera désormais notre vue de dessus.
Enfin, déplacez le curseur dans la vue en bas à droite et appuyez sur la
touche [0] du pavé numérique : ce sera la vue depuis la caméra.

Nous allons maintenant supprimer le cube par défaut. Sélectionnez-le en cli-
quant dessus, dans n’importe quelle vue 3D, à l’aide du bouton droit de la
souris : le cube apparaît désormais surligné en orange clair. Pour le supprimer,
allez dans le menu Object et choisissez Delete ou, plus rapidement, appuyez
sur la touche [X]. Blender vous demande si vous souhaitez effacer les objets
sélectionnés : « Delete ? » Appuyez sur la touche [Entrée] pour valider.

Figure 3–1 Les vues 3D, après réaménagement de l’espace de travail (les autres vues n’ont pas été modifiées).
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Modélisation de la carafe
La première partie de ce chapitre va consister à vous guider pas à pas
dans la modélisation d’une carafe. Ce type d’objet est très pédagogique
et vous donnera la satisfaction d’apprendre plusieurs astuces. En effet, il
est suffisamment simple pour que vous puissiez arriver au bout de sa
modélisation (ce qui est motivant !) et assez riche pour vous permettre
d’appliquer plusieurs outils très utiles (ce qui est intéressant !).

Tracé du profil de la carafe
Placez le curseur de la souris dans la vue de face (la plus grande des
vues 3D, à gauche). Effectuez le raccourci clavier [Ctrl]+[flèche Haut] : la
vue 3D occupe désormais tout l’espace disponible. Pas de panique : pour
revenir à l’espace de travail précédemment défini, effectuez le raccourci
[Ctrl]+[flèche Haut] ou [Ctrl]+[flèche Bas], les deux combinaisons permet-
tant indifféremment de basculer de la taille maximisée à la taille normale
de la vue.

Le curseur est normalement au centre de la vue. Si ce n’est pas le cas, affi-
chez, via la touche [N], le panneau des propriétés numériques et, dans la
section 3D Cursor, saisissez la valeur 0 dans chaque champ Location.

Il sera pratique, pour la suite, d’activer à la fois l’étagère à outils [T] et le
panneau des propriétés numériques [N].

Pour tracer le profil de notre carafe, nous allons commencer par insérer
un objet de type Grid (grille) au centre de notre scène. Pour ce faire, dans
le menu principal, cliquez sur Add, puis Mesh et enfin Grid. Si vous sou-

APARTÉ   Utilisation de la Quad View

Si le redécoupage des vues vous est trop fastidieux ou si vous avez l’habitude de travailler
avec des vues orthonormées (par exemple, formation avec des logiciels de CAO), vous pouvez
activer l’ensemble des vues orthonormées prédéfinies de Blender. Avec le curseur de la souris
dans la vue 3D, affichez le panneau des propriétés numériques grâce à la touche [N] puis,
dans la section Display, cliquez sur le bouton Toggle Quad View.
L’écran est alors divisé en trois vues orthonormées (laissant donc apparaître les grilles en
arrière-plan) : Top (dessus), Front (face) et Right (droite). Ces vues sont statiques, c’est-à-
dire que la seule chose que vous puissiez modifier, outre le mode d’affichage, est le niveau de
zoom. Une quatrième vue, Camera Persp, affiche la scène depuis la caméra active. Cette
vue fonctionne de façon conventionnelle et elle vous offre la possibilité de naviguer librement
dans l’espace en faisant tourner la scène. Elle permet également le basculement entre vue
orthonormée (Ortho) et vue en perspective (Persp) grâce à la touche [5] du pavé numérique.
Étant donné qu’il s’agit d’une même vue 3D, une seule étagère à outils (touche [T]) et un seul
panneau des propriétés numériques (touche [N]) sont disponibles pour l’ensemble.

Figure 3–2
Il est possible de positionner très précisément 
le curseur 3D en saisissant ses coordonnées.

ASTUCE   
Repositionner le curseur 3D au

 centre de la grille grâce au menu Snap

Dans une vue orthonormée de votre choix, cliquez
avec le bouton gauche de la souris au centre de la
scène, symbolisé par une barre verticale bleue et/
ou deux barres horizontales rouge et verte.
Appuyez alors sur la combinaison de
touches [Maj]+[S] et, à la demande de Blender,
choisissez l’option Cursor to Grid. Le curseur est
désormais, dans cette vue, parfaitement aligné sur
la grille. Cette manipulation est à réaliser dans au
moins deux vues orthonormées de votre choix (par
exemple, Top et Front) pour garantir que le cur-
seur sera bien positionné au centre de la grille.
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haitez respecter la règle d’or de Blender (une main sur le clavier, une
autre sur la souris), appuyez sur la combinaison [Maj]+[A] d’une main,
puis de l’autre, choisissez Mesh, puis Grid dans les menus déroulants.

Vous noterez que dans l’étagère à outils, à gauche de la vue, des options
permettent de contrôler interactivement le nouvel objet inséré. En parti-
culier, la grille apparaît dans le plan horizontal, alors que nous aurions sou-
haité l’avoir dans le plan vertical : activez l’option Align to View. Ensuite,
saisissez la valeur 3 pour les champs X Subdivisions et Y Subdivisions.

Une grille a effectivement été ajoutée. Trois remarques peuvent être
faites à ce propos.
1 La grille apparaît automatiquement en mode Object, comme tout

objet ajouté au travers du menu Add. Dans l’en-tête de la vue 3D,
choisissez Edit Mode à la place d’Object Mode, ou basculez de l’un à
l’autre grâce à la touche [Tab].

2 Tous les sommets composant la grille apparaissent alors en orange,
indiquant qu’ils sont tous sélectionnés.

3 Les facettes reliant les sommets apparaissent en orange plus terne,
indiquant qu’elles sont également sélectionnées, la facette active de la
sélection apparaissant garnie de points blancs sur fond gris.

Nous allons tout désélectionner. Pour ce faire, dans le menu Select, choi-
sissez Select/Deselect All. Pour être plus efficace et plus rapide, utilisez le
raccourci clavier correspondant, la touche [A]. Tous les sommets appa-
raissent désormais en noir, indiquant qu’ils sont désélectionnés, et les
faces reliant les sommets deviennent grises.

Nous allons maintenant sélectionner tous les sommets, à l’exception du
sommet central. Pour ce faire, plusieurs méthodes s’offrent à nous.

Figure 3–3 Les caractéristiques de la grille 
sont déterminées dans les propriétés 

interactives de l’étagère à outils.

Figure 3–4
En modélisation polygonale, le point de départ

est souvent une primitive très simple.

ASTUCE  
 Modifier l’affichage 

d’une vue 3D au clavier

Les touches du pavé numérique portant des flè-
ches de direction peuvent également servir à
modifier l’affichage d’une vue 3D. Par exemple,
grâce aux touches [2], [8], [4] et [6], il est pos-
sible de faire tourner le point de vue respective-
ment vers le haut, vers le bas, vers la droite et vers
la gauche. Si vous maintenez la touche [Ctrl] ou
[Maj] pressée, les mêmes touches servent à trans-
later le point de vue vers le haut, vers le bas, vers
la gauche et vers la droite. Enfin, les touches [+]
et [-] du pavé numérique permettent de zoomer
en avant ou en arrière à volonté.
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1 Sélectionnez, par exemple, le sommet supérieur gauche en cliquant
dessus avec le bouton droit de la souris (qui apparaît désormais en
blanc). Maintenez alors pressée la touche [Maj] et employez de nou-
veau le bouton droit de la souris pour ajouter les autres sommets
indésirables à la sélection courante.

2 Dans le menu Select, choisissez Border Select, ou plus directement,
appuyez sur la touche [B]. Grâce au bouton gauche de la souris, vous
pouvez cliquer-glisser pour dessiner des cadres autour des sommets à
supprimer. Lorsque vous relâchez la souris, les sommets encadrés
sont sélectionnés et apparaissent en orange.

3 Dans le menu Select, choisissez Circle Select ou, plus directement, uti-
lisez [C]. Le curseur de la souris s’entoure alors d’un cercle de sélec-
tion (dont le rayon peut être augmenté ou diminué grâce aux
touches [+] ou [-] du pavé numérique). Via le bouton gauche de la
souris, vous pouvez venir « peindre » les sommets à supprimer ; ceux-
ci deviennent orange à mesure que le cercle de sélection passe dessus
et jusqu’à ce que le bouton gauche soit relâché.

4 Chaque utilisateur a ses propres réflexes et méthodes pour sélec-
tionner ou désélectionner des points, en fonction de l’objectif
recherché et de la complexité du modèle. Une autre alternative aurait
été ici de sélectionner le point central seul, grâce au bouton droit de la
souris, puis d’inverser la sélection grâce au menu Select>Inverse ou à la
combinaison [Ctrl]+[I].

Tous les sommets, à l’exception de celui qui figure au centre de la grille,
sont désormais sélectionnés. Pour effacer, choisissez Mesh puis Delete
dans le menu ou, plus simplement, appuyez sur la touche [X]. Une boîte

Figure 3–5 Seuls deux sommets du maillage initial sont conservés.

ASTUCE   
Désélectionner les sommets

La sélection des sommets s’opère simplement,
sommet par sommet : il suffit, tout en conservant
la touche [Maj] enfoncée, de cliquer sur un
sommet que vous souhaitez exclure de la sélection
existante.
En mode Border Select ou Circle Select, nous
avons vu que le bouton gauche permet de
sélectionner ; a contrario, le bouton central désé-
lectionne soit en dessinant une boîte (Border
Select), soit en peignant les sommets à exclure
(Circle Select).

Figure 3–6
La suppression sélective
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de dialogue apparaît, Blender vous demandant ce que vous souhaitez
effacer au sein de la sélection.

Choisissez Vertices pour effacer les sommets sélectionnés. Les arêtes liées
à ces sommets disparaissent alors, de même que les faces reliant ces
arêtes, ne laissant plus que le sommet central.

Le premier point de notre profil est donc désormais seul au centre de la
scène. Il est théoriquement sélectionné ; si ce n’est pas le cas, cliquez
dessus avec le bouton droit de la souris.

Maintenant, nous allons ajouter d’autres sommets à la sélection cou-
rante, à partir du dernier point sélectionné : en maintenant appuyée la
touche [Ctrl], cliquez avec le bouton gauche de la souris sur la position
du prochain sommet, et ainsi de suite. Constituez ainsi le profil de votre
carafe, de sorte à ce qu’il ressemble à peu près à la figure suivante.

Ne paniquez pas si vous ne placez pas vos points exactement là où vous
l’auriez souhaité. Pour corriger les imperfections, vous avez plusieurs
options.
• À tout moment, vous pouvez annuler la dernière opération en utili-

sant la combinaison [Ctrl]+[Z].
• Vous pouvez sélectionner un sommet mal placé (il apparaît alors en

orange ; faites attention à ce qu’aucun autre sommet ne soit sélectionné.
Au besoin, sélectionnez et désélectionnez tous les sommets grâce à la
touche [A]), puis appuyez sur la touche [G] (pour Grab, soit « attraper »
en français). La sélection suit désormais le mouvement de la souris, mais
alternativement, pendant la transformation, vous pouvez employer les
touches de direction du clavier (mais pas celles du pavé numérique !)
pour déplacer la sélection, la touche [Ctrl] pour forcer le déplacement
par incréments, ou les touches [X], [Y] ou [Z] pour forcer le déplacement
dans une direction globale. Comme d’habitude, la touche [Entrée] ou le
bouton droit de la souris valident la nouvelle position.

• Vous pouvez sélectionner un sommet particulier et, dans le panneau
des propriétés numériques [N], dans la section Transform, vous
pouvez modifier ou saisir des valeurs particulières pour les
coordonnées X, Y et Z du sommet. En particulier, pour le dernier
point de notre profil, qui doit impérativement se trouver sur l’axe ver-
tical, vous saisirez une valeur de X 0.

• Plutôt que de construire votre profil à coups de [Ctrl]+[bouton
gauche], vous pouvez choisir d’extruder une arête à partir d’un
sommet sélectionné grâce à la touche [E], l’avantage étant que comme
vous devez valider la position de l’extrémité de la nouvelle arête, vous
pouvez à nouveau vous servir des touches [Ctrl], [X], [Y] ou [Z] pour
contraindre celle-ci à une position plus précise.

ASTUCE   
Activer et désactiver 

le 3D Manipulator widget

Par défaut, l’option 3D Manipulator widget est
activée. Il s’agit de l’icône représentant un repère
tricolore orthonormé dans l’en-tête de la vue 3D.

Figure 3–7 Au centre, le repère tricolore 
orthonormé active l’option 3D Manipulator 
widget.

Cliquez sur cette icône pour la désactiver, ou utilisez
le raccourci clavier [Ctrl]+[Espace] pour l’activer
ou la désactiver au rythme de vos besoins. Le mani-
pulateur qui apparaît à l’écran peut vous compliquer
la tâche lorsque vous êtes en mode Edit ou, au con-
traire, se révéler pratique et utile en mode Object.
En particulier, il est redoutable en mode Pose (pose
des armatures), avec le mode Local d’orientation de
transformation ([Alt]+[Espace]).

ASTUCE  
 Besoin d’afficher une grille 

en arrière-plan ?

Si vous n’utilisez pas la Quad View, vos vues 3D
sont soit en perspective (Persp), soit en vue ortho-
gonale (Ortho). Un plan de référence horizontal
s’affiche en permanence quel que soit le type de vue
mais ne constitue pas, pour autant, une grille utile.

Toutefois, il est bon de savoir qu’une grille
s’affiche automatiquement en arrière-plan si les
deux conditions suivantes sont réunies.
• La vue est de type Front, Face ou Right (ou

leur opposées).
• La projection de la vue est de type Ortho (et

non pas Persp) : la touche [5] du pavé numé-
rique permet alors de basculer d’un mode à
l’autre.
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Vous pouvez maintenant quitter le mode Edit, en appuyant sur la touche
[Tab] ou en choisissant Object Mode dans l’en-tête de la vue 3D, et
retourner à l’affichage standard de Blender, avec toutes les vues 3D et la
fenêtre des boutons, telles que nous les avons laissées, grâce à la combi-
naison de touches [Ctrl]+[flèche Bas] du clavier, avec bien sûr le pointeur
de la souris dans la vue 3D qui occupe l’essentiel de l’écran.

Transformer le profil en objet
Nous avons maintenant notre profil en 2D. Tout ce qu’il nous reste à faire,
c’est de faire tourner ce profil sur lui-même, pour générer l’objet qui servira
de base à notre carafe. Entrez en mode Edit de l’objet grâce à la touche
[Tab] et sélectionnez tous les sommets via la touche [A]. Notez que si vous
aviez un ou plusieurs points sélectionnés à la fin de l’étape précédente, une

Figure 3–8
Par ajouts successifs de sommets, 
nous obtenons la courbe de notre objet.

BON À SAVOIR   
Créer des faces à partir de sommets

Cela n’est pas rigoureusement nécessaire dans
notre cas mais vous pouvez, à titre d’exercice,
sélectionner les sommets par groupes de trois ou
quatre (préférez effectuer la sélection de sorte
qu’aucun des triangles ou quadrilatères ne soit
trop écrasé ou distendu, autant que possible), et
appuyer sur la touche [F]. Une face réunit alors les
sommets sélectionnés, ajoutant au passage les
arêtes nécessaires.
La fonction Make Edge/Face, comme son nom
anglais l’indique, fonctionne aussi bien entre som-
mets qu’entre arêtes, générant aussi bien arêtes
que facettes selon ce qui est possible, sans toute-
fois ajouter de nouveaux sommets.
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première pression sur la touche [A] désélectionnera ces sommets-là, puis
une seconde pression sélectionnera la totalité des sommets.

Maintenant, inspectez l’étagère à outils [T] et dans la section Add, que vous
ne trouverez que si vous êtes bien en mode Edit, remarquez le bouton Spin.

Il va nous permettre de transformer notre profil en un objet de révolution ;
nous saisirons donc une valeur de 360 dans le champ Degrees. Ensuite,
nous souhaitons une circonférence relativement lisse ; nous spécifierons
donc une valeur de Steps modérément élevée, par exemple : 20. Il nous faut
ensuite définir le vecteur qui deviendra l’axe de révolution de notre profil.
Si vous avez construit le profil dans la vue de face (Front), l’axe de révolu-
tion est l’axe Z vertical, soit un vecteur dont les composantes X et Y sont
nulles ; choisissons une valeur égale à 1.00 pour le champ Z.

N’ayez pas peur, dans les propriétés interactives de l’étagère à outils, de
jouer avec les valeurs de ces champs : tant que vous n’engagerez pas une
nouvelle opération (sélection, transformation, changement de mode,
etc.), les nouveaux paramètres s’appliqueront en temps réel à la forme de
révolution dans la vue 3D. Dans le cas où les paramètres auraient été
appliqués prématurément, rappelez-vous le raccourci clavier [Ctrl]+[Z]
qui vous permettra d’annuler l’outil Spin et de relancer celui-ci : Blender
réaffichera alors les derniers paramètres validés.

PRATIQUE   Modifier un champ numérique

Blender tolère plusieurs méthodes pour modifier un champ numérique. Tout d’abord, à la
souris. Remarquez qu’un champ numérique a souvent, de part et d’autre de la valeur numé-
rique, des petites flèches pointant vers la gauche et vers la droite. En cliquant (bouton gauche
de la souris) au centre et en décalant la souris vers la droite (sans relâcher le bouton de
souris), vous augmentez la valeur ; vers la gauche, vous la diminuez.
Vous pouvez également cliquer directement sur la valeur numérique : elle est automatique-
ment sélectionnée et vous pouvez alors taper la valeur de remplacement.

Figure 3–9 Le panneau consacré aux outils 
affectant le maillage

Figure 3–10
Les paramètres de l’outil Spin

Figure 3–11
Après vingt rotations successives du profil,

notre objet gagne en volume.
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L’objet vient de prendre soudainement corps sous nos yeux, Blender s’étant
automatiquement occupé de la génération des arêtes et des faces intermé-
diaires entre les profils clonés et pivotés. Vous noterez qu’au terme de l’opé-
ration, seuls les sommets correspondant au profil initial sont sélectionnés.
Si nous regardons les statistiques, dans la barre de menus principale, nous
remarquerons la catégorie Verts: 12-252. Notre profil comporte douze
points (c’est effectivement le premier des deux nombres séparés par un
tiret). Nous avons spécifié que le profil subirait une rotation en 20 étapes.
Théoriquement, nous devrions avoir un total de 240 sommets (20 × 12).
Or, nous en avons au total 252, soit 12 de trop. Cela est dû au fait que le
dernier profil mis en rotation s’est superposé au profil initial. Nous avons
donc des sommets coïncidents occupant le même espace. Au moment du
rendu, cela se traduira par une arête vive sur un profil autrement lisse. Il
n’est pas pratique de chercher à éliminer un à un les points coïncidents. Le
plus simple est à nouveau de s’en remettre aux outils de Blender.

Toujours en mode Edit, appuyez deux fois sur la touche [A] afin de sélec-
tionner tous les sommets de l’objet ; ils apparaissent désormais en
orange, de même que les faces transparentes, en semi-transparence.
Dans l’étagère à outils [T], repérez le bouton Remove Doubles et cliquez
dessus ; on vous propose alors de régler la distance de fusion des points
considérés comme coïncidents. Conservez la valeur Merge Distance à
0.0001, qui convient très bien ici.

Blender vous informe qu’il a supprimé 50 points coïncidents
(Removed 50 vertices) ce qui est bon signe, puisque nous savions qu’il y en
avait. Mais pourquoi 50 ? Tout simplement parce que les deux points
extrêmes du profil, situés sur l’axe Z de révolution, ont également été
dupliqués 20 fois. Dans la partie information à droite du menu principal,
les statistiques indiquent désormais Verts: 202-202.

Vous pouvez maintenant quitter le mode Edit (touche [Tab] ou choisissez
Object Mode dans l’en-tête de la vue 3D).

Améliorer l’aspect de la carafe
Nous allons maintenant nous attacher à donner une meilleure allure au
corps de notre carafe. Pour y parvenir, nous allons intervenir à deux niveaux.
• Au niveau de l’affichage : il existe une astuce consistant à « lisser »

l’ombrage des facettes, de sorte que l’on ait l’illusion d’une surface
sans facettes. Il s’agit de l’option de shading Smooth.

• Au niveau du maillage : le profil aurait pu être composé d’un plus
grand nombre de points. La rotation de celui-ci aurait aussi pu se
découper en un plus grand nombre d’étapes de sorte que les facettes
auraient été plus petites et, donc, l’objet plus lisse. Il existe un algo-
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rithme qui sous-divise le maillage de base en le lissant, de façon vir-
tuelle, de sorte que le maillage d’origine est préservé. Il s’agit du
modificateur Subdivision Surface.

L’usage de ces deux astuces conduit à des maillages plus lisses tout en
épargnant les efforts de l’utilisateur de Blender.

Lissage de l’ombrage des facettes
Le bouton Smooth se trouve dans l’étagère à outils [T], dans la catégorie
Shading. En cliquant dessus, l’ombrage de la carafe est immédiatement
affecté et suggère une surface parfaitement lisse. À noter toutefois que la
géométrie de la carafe n’est pas altérée : si vous observez les « bords » de
la carafe par rapport à l’arrière-plan, vous constatez que les segments la
constituant sont toujours très visibles.

BON À SAVOIR   Différence entre Catmull-Clark et Simple Subdiv

Les deux méthodes sont proposées comme option lorsque vous mettez en œuvre le modifica-
teur Subdivision Surface.
Simple va conserver la géométrie d’origine, et simplement diviser régulièrement le maillage
d’origine un certain nombre de fois. Par exemple, utiliser Simple, avec View égal à 1 sur un
cube, aura pour résultat le même cube dont chaque face sera constituée de quatre sous-facettes.
Catmull-Clark, pour sa part, va non seulement diviser le maillage d’origine, mais, en plus, le
lisser. Pour reprendre l’exemple précédent, l’emploi de Catmull-Clark avec View égal à 1 va
produire une sorte de boule à facettes.
Évidemment, à moins d’appliquer le modificateur avec le bouton Apply, seule la méthode
Catmull-Clark aura un effet immédiatement visible à l’écran, interactivement et en temps
réel. Simple, pour sa part, ne révélera sa présence que si vous utilisez un autre modificateur
affectant interactivement le cube, comme le modificateur Displace associé à une texture, qui
ne fonctionne bien que sur des surfaces finement subdivisées.

Figure 3–12
Notre carafe est toute en facettes mais,

grâce au bouton Smooth,
elle paraît beaucoup plus lisse.
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Lissage de la géométrie de la carafe
Nous allons maintenant découvrir une fonctionnalité quasi magique de
Blender : les modificateurs. Les modificateurs permettent d’altérer « à la
volée » la géométrie de vos objets afin d’en changer l’aspect, mais de
façon réversible : la géométrie d’origine est la seule véritablement
stockée dans le fichier. Le résultat du modificateur est interprété à
chaque opération ou chargement.

En particulier, nous allons nous intéresser au modificateur Subdivision
Surface, qui permet de remplacer le maillage grossier de la carafe par un
maillage plus dense, aux courbes plus harmonieuses. Dans l’éditeur des
propriétés, recherchez l’icône Object Modifiers, et cliquez dessus pour
découvrir le bouton Add Modifier. Dans le menu déroulant qui apparaît,
choisissez Subdivision Surface dans la catégorie Generate.

ASTUCE  Smooth sur des groupes 
de facettes seulement

En mode Edit (touche [Tab]), sélectionnez
les facettes de votre choix et appuyez sur le
bouton Smooth. Quittez le mode Edit.
L’ombrage des seules facettes sélection-
nées a été lissé et les facettes sont claire-
ment visibles en dehors de la sélection. Le
bouton Flat fonctionne à l’inverse de
Smooth : il révèle les facettes.

Figure 3–13
Une ligne de facettes sur deux

est soumise au bouton Smooth,
l’autre à Solid.

ASTUCE   
Rendre permanent un modificateur

Cliquer sur le bouton Apply associé au modifica-
teur fige sa géométrie telle quelle en remplaçant,
dans la mémoire de Blender, la géométrie d’origine.

Figure 3–14
Ajout d’un modificateur de type Subdivision 
Surface. View: 1 allège l’affichage sur les configu-
rations modestes ; passez-le à 2 pour obtenir à 
l’écran le même résultat qu’au rendu (Render: 2).
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Nous allons laisser tels quels tous les paramètres par défaut, mais préci-
sons tout simplement que Catmull-Clark est la méthode de subdivision
que nous retiendrons, que View indique le niveau de lissage dans la
vue 3D et que Render précise celui au moment du rendu. Bien évidem-
ment, plus ces niveaux sont élevés, plus le lissage sera important, mais
plus le modificateur consommera de la mémoire et ralentira le temps de
rendu (et même d’affichage dans les vues 3D).

Modifier le profil
Si vous n’êtes pas tout à fait satisfait des proportions de votre carafe, rien
n’est perdu. Par exemple, nous allons rétrécir la partie supérieure de la
carafe, pour lui donner un peu plus de style. Dans la vue de face, et en
mode Edit (touche [Tab]), utilisez l’outil de sélection Select>Border Select,
ou plus simplement la touche [B], pour tracer une boîte (bouton gauche
de la souris) autour de la deuxième ligne de sommets depuis le haut de la
carafe. Attention, pensez à désactiver la limitation de sélection à la géo-
métrie visible (voir aparté page suivante) sinon seuls les sommets du pre-
mier plan seront sélectionnés. Puis, appuyez sur la touche [S] (pour Size,
« taille » ou « dimension » en français) pour les redimensionner. Dès que
vous aurez appuyé sur la touche [S], le mouvement de la souris va fixer
l’agrandissement ou le rétrécissement de la sélection.

Pour notre part, nous allons appuyer sur la touche [Ctrl] tout au long du
déplacement de la souris, afin que l’augmentation ou la diminution des
dimensions se fasse par incréments réglés plutôt que par valeurs libres.
Observez l’en-tête de la vue pendant cette opération. Elle affichera des
valeurs « rondes » de Size X, Size Y et Size Z, qui indiquent respectivement
le facteur de « redimensionnement » appliqué à la sélection dans les trois

Figure 3–15
Notre carafe, avant et après l’activation

du modificateur Subdivision Surface
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axes de notre repère. Une fois obtenue la forme souhaitée pour la carafe,
appuyez sur la touche [Entrée] pour valider la transformation géométrique.

Vous pouvez alors appuyer sur la touche [A] pour désélectionner tous les
sommets qui le sont. Ne quittez toutefois pas le mode Edit, nous allons
encore transformer notre maillage.

Le bec verseur
Nous allons maintenant ajouter un bec verseur à notre carafe. Nous
aurions plusieurs solutions pour y parvenir, mais celle choisie est un peu
plus pédagogique que les autres. Jusqu’à présent, les opérations de redi-
mensionnement ou de rotation utilisaient comme pivot le centre géomé-
trique de la sélection. Cette option est matérialisée par l’icône Median
Point, dans l’en-tête de la vue 3D.

Avec ce type de pivot actif, le centre de la rotation ou du redimensionne-
ment sera un point immatériel correspondant au centre de gravité de la
sélection. Il s’agit du comportement par défaut, mais d’autres options exis-

À SAVOIR   La limitation de sélection à la géométrie visible 

Il s’agit d’une méthode d’affichage dans la vue 3D qui permet de totalement masquer les
arêtes, sommets et faces en arrière-plan par les faces qui se situent en premier plan. Ainsi, il
est possible d’observer plus facilement la topologie (le maillage) de vos objets, et de n’auto-
riser les sélections que sur les faces en avant. Ainsi, lorsque l’option de limitation de la sélec-
tion à la géométrie visible est active, les sélections (grâce à la fonction Border Select,
touche [B], par exemple) n’affectent pas les faces masquées en arrière-plan.
Pour l’activer ou la désactiver, cliquez dans l’en-tête de la vue 3D sur l’icône représentant les
deux facettes superposées. Attention, cette option n’est disponible que si les facettes sont
visibles dans la vue 3D, c’est-à-dire lorsque l’option Viewport Shading de l’en-tête de la
vue 3D est au minimum sur Solid. Le mode filaire Wireframe ne l’autorise pas notamment.

Figure 3–16 Avant-dernière icône, Limit selec-
tion to visible permet de cacher ou de révéler la 
géométrie cachée en arrière-plan.

Figure 3–17
Le col de la carafe est redimensionné.

ASTUCE   
Contraindre une modification 

selon un axe déterminé

Lorsque vous appuyez sur les touches [G], [R] ou
[S] pour déplacer, faire tourner ou redimensionner
un objet, vous pouvez enchaîner avec les
touches [X], [Y] ou [Z] pour contraindre la modi-
fication selon l’axe correspondant. Par exemple, en
vue de de face, si vous appuyez sur la touche [G],
puis sur [Z], la sélection ne sera déplacée que
selon la direction de l’axe Z.

Figure 3–18
Median Point, le pivot par défaut
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tent. Parmi celles-ci, la possibilité de se servir du curseur 3D comme centre
de rotation. Dans l’en-tête de la vue de face, choisissez l’option 3D Cursor.

Positionnez ensuite le curseur (bouton gauche de la souris) à peu près au
niveau du « cou » de la carafe. En utilisant la fonction Snap, grâce à la
combinaison de touches [Maj]+[S], forcez le positionnement du curseur à
une intersection de la grille en choisissant l’option Cursor to Grid lorsque
Blender vous proposera le menu déroulant.

Nous allons maintenant employer un outil à la fois simple et puissant de
Blender : le Proportional Editing Mode (« mode d’édition proportionnelle »
en français). Le principe en est simple : lorsque l’outil est actif, si vous avez
un maillage d’une certaine densité et que vous déplacez un sommet,
Blender va déplacer proportionnellement tous les sommets situés dans le
rayon d’effet de l’outil. Bien évidemment, les sommets à l’extérieur du
rayon d’effet ne sont pas affectés et, à l’intérieur de celui-ci, plus le sommet
sera proche du sommet déplacé, plus il sera déplacé à son tour, selon une
règle proportionnelle, carrée, sphérique ou autre.

Pour activer cet outil, soit vous cliquez sur l’icône appropriée de l’en-
tête, soit vous utilisez le raccourci clavier [O], soit vous passez par le
menu Mesh et cliquez sur Proportional Editing pour choisir l’option
Enable. Dans les trois cas, Blender vous propose plusieurs options (celle
par défaut, que nous conserverons, est tout simplement le mode Enable).

La loi qui gère le déplacement des sommets dans le rayon d’effet de l’outil
est appelée le Proportional Editing Falloff. Par défaut, la loi sélectionnée est
le Smooth Falloff, mais vous pouvez la changer soit en cliquant sur l’icône
appropriée (qui apparaît lorsque vous activez l’outil) et en en sélectionnant
une autre dans le menu déroulant, soit en passant par le menu Mesh et en

Figure 3–19
La nouvelle position du curseur 3D

Un mode d’édition intelligent : 
Connected

Le mode d’édition proportionnelle tient compte
des connexions éventuelles entre la sélection et les
sommets voisins. Lorsque l’option Connected est
active, seuls les sommets situés dans l’aire d’effet
et reliés à la sélection sont affectés.

Figure 3–20
Activation de l’outil d’édition proportionnelle
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cliquant sur Proportional Editing Falloff, puis l’option choisie. Enfin, le
rayon d’effet de l’outil est symbolisé à l’écran par un cercle. Vous pouvez
augmenter son rayon en utilisant la molette de votre souris.

Pour notre carafe, désélectionnez d’abord, grâce à la touche [A], tous les
sommets éventuellement sélectionnés. Puis activez le mode d’édition pro-
portionnelle grâce à la touche [O] et conservez l’icône Smooth par défaut qui
devient disponible comme type de Falloff. Dans la vue de dessus (Top
Ortho), appuyez sur la touche [C] pour activer l’outil Circle Select ; un cercle
d’effet apparaît et vous pouvez en régler le rayon grâce aux touches [+] et [-]
du pavé numérique, ou grâce à la molette de la souris.

Comme nous allons faire une sélection assez fine, appuyez quelques fois
sur la touche [-] pour diminuer sensiblement la taille du cercle d’effet et,
sur la vue de dessus, sélectionnez les deux points situés sur la ligne hori-
zontale et correspondant au sommet de la carafe à l’aide du bouton
gauche de la souris.

Faites tourner la vue 3D pour vous assurer que d’autres points indésira-
bles n’ont pas été sélectionnés. Au besoin, employez le bouton central de
la souris pour les enlever de la sélection.

Si la sélection vous convient, validez via le bouton droit de la souris (ou la
touche [Entrée]). Maintenant, revenez dans la vue de face. Nous avons
désormais tout ce qu’il nous faut : un centre de rotation défini comme
étant le curseur 3D et une sélection de points prêts à être mis en rotation.
En fait, il ne nous manque plus qu’à réaliser la rotation. Cela se fait au
moyen de la touche [R] (pour Rotate, « faire tourner » en français). Le
rayon d’effet est certes assez grand, mais ne vous laissez pas
impressionner : déplacez le curseur de la souris et observez la valeur en bas
de la vue 3D ; elle indique en temps réel l’angle de rotation de la sélection.

Figure 3–21
Réglages possibles du Falloff

ASTUCE   
Quelques combinaisons de touches 

pour régler le rayon d’effet

Les combinaisons de touches [Alt]+[+] et
[Alt]+[-] du pavé numérique ou, plus simple-
ment, les touches [PageUp] et [PageDown]
permettent également de changer le rayon d’effet
du mode Proportional Editing.

Figure 3–22
Sélection des points à faire tourner autour du curseur 3D

ASTUCE   
Utiliser des valeurs réglées

Lorsque vous transformez un objet, il est difficile
d’être très précis à la souris et de contrôler la
portée de cette modification, surtout si vous
« visez » des valeurs rondes ou précises. En main-
tenant la touche [Ctrl] pressée pendant le mouve-
ment de la souris, vous contraignez la
transformation à des multiples d’une unité entière
pour les opérations de déplacement (touche [G]),
de 5° pour les opérations de rotation (touche [R]),
ou d’un facteur multiplicatif de 0,1 pour les opéra-
tions de redimensionnement (touche [S]).
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Maintenez appuyée la touche [Ctrl] et déplacez la souris jusqu’à obtenir un
angle de -35.00°, mais ne validez pas encore. Lâchez d’abord la souris
(délicatement, pour ne pas la bouger) puis la touche [Ctrl], et utilisez
ensuite les touches [PageUp] et [PageDown] pour régler le rayon d’effet de
l’outil d’édition proportionnelle jusqu’à obtenir la forme souhaitée. Vous
pouvez maintenant valider la rotation grâce à la touche [Entrée].

Appuyez sur la touche [A] pour désélectionner tous les points qui le sont
mais ne quittez pas encore le mode Edit : il nous reste encore un acces-
soire important à donner à notre carafe !

Ajout de l’anse
Les outils de modélisation de Blender étant variés et versatiles, nous dis-
posons, ici aussi, pour ajouter une anse à la carafe, de nombreuses

Figure 3–23
Angle de rotation lisible en temps réel

Figure 3–24 La carafe est désormais presque complète.

Mode de sélection

Par défaut, lorsque vous utilisez un outil de sélec-
tion, ce sont des sommets que vous sélectionnez.
Mais dans certains cas, il est plus intéressant
d’appliquer certains outils (comme Extrude) à des
arêtes ou des faces, plutôt qu’à des sommets. Dans
l’en-tête, vous pouvez spécifier aisément le mode
de sélection courant. Dans l’illustration qui suit, le
bouton avec le petit point active la sélection de
sommets, celui avec le segment vertical active la
sélection d’arêtes et, enfin, celui avec la facette
active la sélection de faces.

Figure 3–25 Les trois premiers boutons 
permettent d’activer respectivement 
la sélection de sommets, d’arêtes et de faces.

À noter que si vous maintenez la touche [Maj]
pressée pendant que vous choisissez un mode de
sélection, il devient possible de mélanger les
modes de sélection !
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méthodes. Nous en choisirons bien sûr une qui nous permettra de
découvrir des facettes intéressantes de Blender.

Dans un premier temps, cliquez sur l’icône Limit selection to visible dans
l’en-tête afin de masquer à nouveau la géométrie en arrière-plan. Désor-
mais, lorsque vous utiliserez un outil de sélection comme Border Select ou
Circle Select, la sélection ne portera que sur les faces, arêtes et sommets
visibles du premier plan. Ensuite, dans l’onglet Object Modifiers de l’édi-
teur des propriétés, le modificateur Subdivision Surface doit être actif ;
passez la valeur de View à 2 afin que le tracé à l’écran corresponde bien à
celui du rendu. Enfoncez le bouton Optimal Display. À droite du nom du
modificateur se trouve une série d’icônes ainsi que des curseurs pointant
vers le haut et le bas. Cliquez sur le dernier bouton avant les flèches pour
l’activer : l’apparence de votre carafe dans la vue 3D prend immédiate-
ment une autre allure !

Placez-vous dans la grande vue 3D à gauche (qui contient actuellement
la vue de face) et basculez-la en vue de côté, grâce à la touche [3] du pavé
numérique. Ensuite, dans l’en-tête, activez le mode de sélection de faces.

Dans cette vue depuis le côté droit, activez l’outil Circle Select en
appuyant sur la touche [C]. Diminuez le rayon du cercle de sélection
grâce à la touche [PageDown] ou en actionnant la molette de la souris,
puis sélectionnez les deux faces centrales de la deuxième rangée de faces.

Revenez en vue de face grâce à la touche [1]. Nous allons construire une
anse à notre carafe, en extrudant celle-ci à partir de notre sélection. Dans
le menu Mesh, choisissez Extrude Region ou appuyez sur la touche [E].
Blender affiche alors la normale à la sélection selon laquelle les facettes
seront extrudées. Déplacez un peu la sélection vers le haut mais pas trop,
et validez avec le bouton gauche de la souris.

BON À SAVOIR   Les options du modificateur 
Subdivision Surface

Immédiatement à droite du nom du modificateur
(par défaut : Subsurf), les quatre icônes servent à
indiquer à quoi le modificateur doit s’appliquer.
• Use modifier during rendering : active le

modificateur au cours du rendu ; souvent,
lorsqu’un objet est en arrière-plan de la scène,
désactiver cette option permet d’économiser de
la mémoire.

• Display modifier in realtime : active le
modificateur dans la vue 3D ou dans le moteur
de jeu.

• Use modifier while in Edit mode : affiche
la surface subdivisée en plus du maillage d’ori-
gine, également appelé « cage ».

• Apply modifier to editing cage during
Edit mode : projette le maillage d’origine sur la
surface subdivisée, ce qui autorise un retour visuel
beaucoup plus efficace. Cette option est souvent
incontournable en modélisation organique.

Figure 3–26 Il est possible de contrôler fine-
ment le champ d’application d’un modifica-
teur.

Figure 3–27
Le modificateur Subsurf et l’option 
« Apply modifier to editing cage during 
Edit mode » en action

Figure 3–28
Le bouton avec la facette est celui permettant 

d’activer le mode de sélection de faces.

Le saviez-vous ?

Si les touches [7], [1] et [3] affichent respective-
ment les vues de dessus, de face et de côté droit,
les touches [Ctrl]+[7], [Ctrl]+[1] et [Ctrl]+[3]
affichent pour leur part les vues de dessous, de
derrière et de côté gauche.
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Comme pivot des transformations, choisissez l’icône Median Point, puis
désactivez le mode d’édition proportionnelle grâce à la touche [O].
Ensuite, dans la vue de dessus, appuyez sur la touche [S] pour diminuer
la section de la sélection. Validez avec le bouton gauche de la souris ou
appuyez sur la touche [Entrée].

Essayez ensuite d’équilibrer la section de la sélection de sorte que lon-
gueur et largeur soient à peu près équivalentes, en contraignant les trans-
formations respectivement dans les directions X et Y. Ainsi, la succession
des touches [S][Y] permettra de ne redimensionner la sélection que dans
la direction Y.

Nous allons découvrir une nouvelle façon de générer du volume, bien
que la fonction d’extrusion (touche [E]) soit très intéressante. De retour
dans la vue de face (touche [3]) et en mode Ortho (touche [5]), vous allez
utiliser la combinaison [Ctrl]+[bouton gauche] de la souris pour extruder
la sélection jusqu’à la position courante du pointeur de la souris.

Figure 3–29
Sélection des deux faces à partir desquelles

l’anse va être tirée.

Figure 3–30
Première étape d’extrusion
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Le point intéressant c’est que si vous enchaînez cette opération tout en
faisant suivre à vos clics une trajectoire courbe, pour peu que l’espace-
ment entre deux [Ctrl]+[bouton gauche] soit suffisamment faible, Blender
va automatiquement interpoler la rotation des facettes extrudées de sorte
à ce qu’elles suivent de façon naturelle la courbure de la trajectoire.

Après avoir répété l’opération un certain nombre de fois, vous obtenez
donc une anse complète ; n’hésitez pas à revenir en arrière grâce à la
combinaison [Ctrl]+[Z] si la courbure de l’anse n’est pas satisfaisante ou si
celle-ci vient pénétrer dans le corps de la carafe.

Figure 3–31 Redimensionnement de l’excroissance dans la direction Y 
grâce à la succession de touches [S][Y]

Figure 3–32 Par [Ctrl]+[bouton gauche] successifs, 
l’anse se dessine.

BON À SAVOIR   Générer des volumes librement à la souris

Lorsque vous utilisez une succession de [Ctrl]+[bouton gauche] pour ajouter du volume à
votre modèle, le chemin de celui-ci est toujours dans le plan de la vue 3D. Cela veut dire que
vous aurez tout intérêt à travailler dans les vues principales (Front[1], Right[3], Top[7] ou
leurs opposés) si vous voulez garantir que les volumes créés respectent ces directions. C’est le
cas de l’anse dans l’exercice de modélisation de la carafe.
En revanche, dans le cadre d’une modélisation plus « organique », par exemple un arbre, vous
gagnerez à travailler uniquement dans des vues en perspective que vous ferez varier de façon
plus ou moins importante entre un [Ctrl]+[bouton gauche] et un autre.
Vous noterez enfin que la nature de la sélection définit le résultat obtenu : s’il s’agit d’un
sommet (ou d’un ensemble de sommets non connectés), le résultat produit sera une arête (ou
un ensemble d’arêtes) ; s’il s’agit d’une arrête (ou d’un ensemble d’arêtes non connectées), le
résultat sera une facette (ou un ensemble de facettes non connectées).
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Pour parachever l’aspect esthétique de votre anse, redimensionnez
l’extrémité de la carafe grâce à la touche [S].

Pensez maintenant à quitter le mode Edit, soit grâce à la touche [Tab],
soit en choisissant Object Mode dans l’en-tête de la vue 3D.

Pousser la modélisation : création 
d’un environnement rudimentaire
Vous avez fini de modéliser votre carafe ! C’est déjà un grand pas dans
votre apprentissage du logiciel, mais cette étape à elle seule n’est pas suf-
fisante pour l’obtention d’une image intéressante.

Figure 3–33
L’anse enfin complète

Figure 3–34
L’extrémité de l’anse est

affinée individuellement.



3 
– 

Pr
em

ie
r p

ro
je

t a
ve

c 
Bl

en
de

r

© Groupe Eyrolles, 2013 75

Pour l’instant, la carafe « flotte » dans les airs, nous allons donc essayer
de lui donner une surface sur laquelle s’appuyer. Positionnez le curseur
3D au centre de la scène. Pour cela, vous avez deux options.
• Grâce au bouton gauche de la souris, cliquez en vue de face et en

mode Ortho (Front, touche [3] et touche [5] si nécessaire) et posi-
tionnez le curseur sur la grille grâce à la combinaison [Maj]+[S] et en
choisissant l’option Cursor to Grid. Répétez l’opération dans une autre
vue au choix.

• Dans le panneau des propriétés numériques (activé grâce à la
touche [N]), repérez la section 3D Cursor et tapez la valeur 0.0000
pour chacune des coordonnées X, Y et Z.

Insérons maintenant un nouvel objet dans la scène. Cela se réalise très
simplement de deux façons possibles.
• Passez par le menu Add, puis choisissez Mesh>Plane.
• Utilisez la combinaison [Maj]+[A] (pour Add) qui va appeler le même

menu d’ajout, et choisissez à nouveau Mesh>Plane.

Un plan fait son apparition sous la carafe, mais ses dimensions sont trop
petites pour figurer une surface crédible, comme une table. Dans la sec-
tion Transform des propriétés numériques [N], spécifiez une valeur égale
à 10.000 pour les champs X et Y du paramètre Scale.

Nous avons désormais une table convenable, mais la scène reste désespé-
rément dépeuplée. Nous allons en profiter pour découvrir une notion
bien utile de Blender : la duplication d’objets. Pour cela, sélectionnez la
carafe à l’aide du bouton droit de la souris et placez-vous en vue de
dessus (Top, touche [7] du pavé numérique). Dans le menu de l’en-tête
de la vue 3D, choisissez Object puis Duplicate Object (ou utilisez la com-
binaison [Maj]+[D]) : une seconde carafe fait son apparition, surlignée de

Figure 3–35
Une bien jolie carafe, mais qui se sent très seule !

Figure 3–36
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blanc, indiquant qu’une transformation est en cours. Déplacez-la un peu
plus loin et validez sa nouvelle position grâce au bouton gauche de la
souris ou à la touche [Entrée].

Toujours dans la vue de dessus (Top, touche [7]), faites tourner la seconde
carafe sur elle-même grâce à la touche [R] et validez sa nouvelle orienta-
tion à l’aide du bouton gauche de la souris ou de la touche [Entrée]. Puis,
dans la vue de face (Front, touche [3]), redimensionnez-la (par exemple, en
la réduisant) grâce à la touche [S], et validez sa nouvelle dimension tou-
jours grâce au bouton gauche de la souris ou à la touche [Entrée].

Prenons de bonnes habitudes dès maintenant, en faisant de l’éditeur de
type Outliner un allié. Celui-ci présente tous les éléments de la scène. Cer-
tains ont été créés par vos soins, comme Grid et Grid.001 (qui sont respecti-
vement votre carafe et son duplicata miniature), d’autres étaient présents
dès la scène de démarrage, comme Camera ou Lamp. Si certains noms sont
assez explicites, d’autres le sont moins, mais nous allons y remédier.

Figure 3–37
Le plan a été redimensionné

pour symboliser une table.

Figure 3–38
La carafe a été dupliquée

pour créer un cruchon.
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Sélectionnez dans l’éditeur de type Outliner l’entité Grid avec le bouton
gauche et cliquez dessus avec le bouton droit pour appeler un menu con-
textuel. Choisissez Rename et rebaptisez l’objet Carafe. De la même
façon, sélectionnez l’objet Grid.001 et renommez-le Cruchon. Enfin,
renommez Plane en Table.

Nous pourrions nous en tenir là, mais nous allons sélectionner le cruchon
et à nouveau le dupliquer. En vue de dessus (Top, touche [7]), allez dans le
menu Object de l’en-tête de la vue 3D mais, cette fois, choisissez Duplicate
Linked (ou utilisez la combinaison [Alt]+[D]). Placez le duplicata en
arrière-plan de la carafe par rapport à la caméra en validant sa nouvelle
position grâce au bouton gauche ou à la touche [Entrée]. Puis dans la vue
de face (Front, touche [3]), redimensionnez-la (par exemple, en l’agrandis-
sant) grâce à la touche [S], et validez sa nouvelle dimension grâce au
bouton gauche de la souris ou à la touche [Entrée]. Dans l’éditeur de type
Outliner, renommez Cruchon.001 en GrandCruchon par exemple.

BON À SAVOIR   Renommer un objet

Vous pouvez renommer un objet de différentes façons :

• dans l’Outliner, l’usage du bouton droit sur un objet de l’arbre appelle un menu contex-
tuel. Choisissez Rename ;

• dans le panneau des données numériques [N], localisez la section Item et modifiez le
nom de l’objet dans le champ approprié ;

• dans la fenêtre des propriétés, affichez le contenu de l’onglet Object et le premier champ
disponible permet de modifier le nom de l’objet sélectionné.

Figure 3–39

Figure 3–40
Renommage de l’objet Table dans l’Outliner

Figure 3–41
Une collection de carafes clonées !
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La différence par rapport à précédemment est que le nouvel objet est
totalement lié au cruchon : au lieu d’en être un duplicata, il en est un
clone. Toute modification structurelle appliquée sur l’un sera répliquée
sur l’autre, à l’exception des transformations (ce qui permet de déplacer,
tourner, redimensionner indépendamment chaque clone) qui agissent au
niveau de l’objet et non pas de sa structure interne. Nous comprendrons
l’intérêt de cette variante plus tard, lorsque nous affecterons des appa-
rences aux matériaux constituant ces objets.

Notre scène, carafes et environnement compris, est désormais en place.
Mais elle ne fonctionnera correctement que si la caméra est bien posi-
tionnée et l’éclairage satisfaisant. Avec ces deux éléments issus de la
scène par défaut de Blender, il est très improbable que vous obteniez un
résultat satisfaisant.

Occupons-nous tout d’abord de la lumière : dans l’Outliner, sélectionnez
l’objet Lamp et dans les vues de votre choix, déplacez-la (touche [G]) de
sorte qu’elle soit un peu en arrière-plan et au-dessus de la scène. Par
exemple, X 4.0, Y 12.0 et Z 12.0 (valeurs que vous pouvez directement
saisir dans les champs appropriés de la section Transform, paramètres Loca-
tion du panneau des propriétés numériques [N]) peuvent convenir si vous
avez suivi scrupuleusement les proportions des images de ce chapitre.

La caméra est plus difficile à maîtriser : il est souvent utile d’avoir votre
vue 3D partitionnée de sorte à avoir une vue depuis la caméra active
(touche [0] du pavé numérique). On constate alors que, s’il est facile de
positionner la caméra en un endroit particulier, l’orienter de façon à ce
que, dans sa vue, elle affiche la scène désirée, sera le plus souvent difficile
et nécessitera de jongler entre différentes vues.

BON À SAVOIR   Duplicate Objects et Duplicate Linked

Dans les deux cas, un nouvel objet ressemblant au premier fait son apparition, directement en
mode transformation : il est entouré d’un liseré blanc et attend que vous le repositionniez où
vous le souhaitez.

• Duplicate Objects : le duplicata est une simple copie de l’objet, totalement indépen-
dante, offrant généralement une base de travail pour la création d’un modèle différent ;
vous pouvez en modifier la structure interne (par exemple, le maillage) ou changer son
matériau comme bon vous semble, sans que l’objet d’origine ne soit affecté.

• Duplicate Linked : le duplicata est en fait un clone de l’objet sélectionné. À ce titre, si
vous apportez des modifications à la structure interne de l’objet d’origine, l’objet dupliqué
hérite automatiquement des mêmes modifications. Celles-ci sont bidirectionnelles : les
modifications apportées au duplicata se répercutent aussi sur l’original.

Il est important de noter que si les transformations (déplacement, rotation, mise à l’échelle…)
sont réalisées en mode Object, ce ne sont pas des changements à la structure interne, et
qu’elles ne sont, par conséquent, pas transmises d’un clone à l’autre. En revanche, si vous opérez
ces transformations (ainsi que d’autres opérations de modélisation, comme des extrusions sup-
plémentaires) en mode Edit, les modifications sont bien héritées par les autres clones.
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Nous allons donc vous présenter une astuce qui simplifiera la gestion de
la caméra. En vue de dessus (Top, touche [7]), commencez par sélec-
tionner la caméra (bouton droit de la souris), puis déplacez-la
(touche [G]) de manière à l’éloigner du centre de la scène et de façon à ce
que sa vue révèle la quasi-totalité de celle-ci.

Repositionnez à nouveau le curseur 3D au centre de la scène, mais à une
altitude de 10 unités (dans le panneau des propriétés numériques [N],
saisissez des valeurs nulles à chaque paramètre X et Y, puis une
valeur 10.0 à Z de la section 3D Cursor), et ajoutez un nouvel objet grâce à
la combinaison [Maj]+[A] et ensuite à Empty. L’Empty est un type d’objet
spécial de Blender, qui a seulement des coordonnées de position (ainsi
que de rotation et d’autres paramètres, mais qui ne nous intéresseront
pas ici). Par conséquent, il n’apparaît pas sur les images rendues mais
uniquement dans la vue 3D.

Figure 3–42
La lampe éclaire la scène entière, sa position simulant 
grossièrement la lumière d’une ampoule.

Figure 3–43 La caméra a été éloignée, mais elle ne permet toujours pas de capturer l’ensemble de la scène.
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Dans l’Outliner, sélectionnez l’objet Camera avec le bouton gauche de la
souris puis, tout en maintenant la touche [Maj] enfoncée, cliquez à nou-
veau avec le bouton gauche sur l’objet Empty pour l’ajouter à la sélection.
Attention, l’ordre est très important. Dans la vue 3D, la caméra apparaît
en orange foncé, indiquant sa sélection, et l’Empty s’affiche en orange
clair, indiquant qu’il est à la fois sélectionné et actif.

En vous aidant de l’Outliner, sélectionnez la caméra puis l’Empty. Utilisez
maintenant la combinaison [Ctrl]+[T] : un lien automatique se crée entre
la caméra et l’Empty (matérialisé dans la vue 3D par une ligne noire en
pointillés), et la caméra s’est automatiquement réorientée pour fixer
l’Empty. Si vous avez la curiosité de regarder dans l’éditeur des pro-
priétés, dans l’onglet Object Constraints, une nouvelle contrainte de type
TrackTo a fait son apparition ; elle prend pour cible (Target) l’objet Empty.

Vous pouvez maintenant sélectionner l’Empty dans la vue 3D via la
bouton gauche de la souris. Grâce à la touche [G], déplacez-le et
observez la vue depuis la caméra. Elle s’aligne automatiquement en per-
manence sur l’Empty pour conserver celui-ci au centre de sa vue… Vous
l’avez compris, il ne reste plus qu’à déplacer dans les différentes vues la
caméra et l’Empty jusqu’à ce que vous ayez une vue d’ensemble satisfai-
sante de la scène depuis la vue de caméra.

Figure 3–44
En vous aidant de l’Outliner,

sélectionnez la caméra puis l’Empty.

Figure 3–45 L’onglet Object Constraints 
dans l’éditeur des propriétés

Figure 3–46
L’Empty indique précisément à la caméra

ce qu’elle doit fixer, et il ne vous reste
plus qu’à déplacer celle-ci jusqu’à capturer

la scène dans son intégralité.
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Nous allons effectuer un rapide rendu afin de voir à quoi ressemble notre
scène. Dans le menu général de Blender, sélectionnez Cycles Render
comme moteur de rendu.

Il ne vous reste plus qu’à effectuer le rendu de votre scène ! Pour cela,
appuyez sur la touche [F12] ou en passant par le menu, choisissez
Render>Render Image. N’oubliez pas de sauvegarder votre image grâce à
la touche de fonction [F3] ou en passant par le menu Image>Save As
Image de l’en-tête de la fenêtre affichant le rendu.

Nous avons bien avancé ! Notre premier projet a pris une forme
agréable, mais il souffre d’un cruel manque de couleurs. C’est ce à quoi
nous allons nous attaquer maintenant : donner aux modèles des appa-
rence diverses et variées, et affiner la qualité du rendu.

Mise en couleurs de votre première scène
Une belle modélisation ne vaut rien sans un bon éclairage et une mise en cou-
leurs soignée. Dans le cadre de cet exercice dédié à l’apprentissage, nous nous
en tiendrons au service minimum, mais il y aurait beaucoup à dire et à faire à
propos de l’usage des textures qui vont habiller la surface de vos objets.

Figure 3–48
Sélectionnez le moteur de rendu 
Cycles, nouvellement intégré à 
Blender.

ASTUCE  
 Avec Cycles, prévisualisez 
vos rendus dans la vue 3D

Cycles est un moteur de rendu progressif : cela
veut dire, entre autres, que le résultat du rendu
s’affiche progressivement et que, plus vous lui
laissez du temps, plus le résultat s’affine.
Lorsque le moteur de rendu Cycles est sélec-
tionné, il est possible d’afficher n’importe quelle
vue 3D en mode rendu (Rendered), plutôt qu’en
mode solide (Solid) ou filaire (Wireframe). Pour
cela, il suffit d’aller dans l’en-tête de la vue 3D et
de choisir Rendered dans le menu Viewport
Shading.
Comme le processus est progressif, si vous
déplacez un objet (par exemple, une lampe, pour
régler l’éclairage de votre scène!) vous avez le
retour direct de vos modifications sans passer par
la case rendu !

Figure 3–47

Figure 3–49
Notre travail de modélisation enfin achevé !
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Appliquer une texture à votre table
Dans une vue de votre choix (par exemple, depuis celle de la caméra ;
touche [0] du pavé numérique), sélectionnez la table grâce au bouton
droit de la souris. Dans l’éditeur des propriétés, à droite de l’écran, affi-
chez l’onglet Material. Une pile de matériaux (vide) fait son apparition,
ainsi qu’un bouton New, en dessous de la pile.

Bien sûr, si vous cliquez sur ce bouton, un matériau par défaut fait son
apparition. Il se nomme Material et son nom apparaît à la fois dans la
pile de matériaux, ainsi qu’en dessous de celle-ci, à la place du bouton
New et dans un sélecteur de matériaux. Cliquez sur le nom pour le
changer en quelque chose de plus explicite, comme Bois_Table.

Des paramètres font leur apparition, afin de déterminer l’aspect de ce
matériau. Par défaut, la surface est de type Diffuse BSDF, c’est à dire qu’elle
ne permet de contrôler que la couleur de la surface et, dans une certaine
mesure, sa rugosité : un objet lisse réfléchira beaucoup la lumière (surface
brillante), un objet rugueux tendra à l’absorber (surface mate).

Au niveau du champ Color, si vous cliquez sur le bandeau blanc, vous
faites apparaître un sélecteur de couleur. Le disque central sert à choisir
une tonalité de couleur et le bandeau vertical le niveau de luminosité de
celle-ci. Vous pouvez également saisir les composantes RGB (Red, Green,
Blue : soit les taux de rouge, vert et bleu) si vous connaissez celles qui
vous intéressent. Amusez-vous à mettre en place une couleur marron.
Ne touchez pas au paramètre A (Alpha) qui permet de spécifier le niveau
de transparence de cette couleur.

Mais ce n’est pas exactement ce que nous recherchons : à droite du ban-
deau désormais coloré en marron se trouve un petit bouton sélecteur en
forme de point. Si vous cliquez dessus, vous accédez à de multiples don-
nées à mettre en entrée. Nous n’explorerons pas ici les possibilités et

BON À SAVOIR   Déplier l’arborescence 
des objets dans l’Outliner

Chaque item de l’Outliner est précédé d’un
petit signe plus qui indique qu’il est au sommet
d’une petite arborescence. En cliquant sur celui-
ci, vous dépliez l’objet et pouvez visualiser ce
qui le constitue. À ce stade, l’objet Table est
constitué d’un maillage (Plane) auquel est
associé un matériau (Bois_Table).

Figure 3–52

Figure 3–50 Aucun matériau n’est 
pour l’instant assigné à la table.

Figure 3–51
Un nouveau matériau, que nous nous empres-

sons de renommer, est assigné à la table.

ASTUCE   Choisir son code de couleurs

Blender supporte différents types de codes de cou-
leurs, selon les habitudes, préférences ou, tout sim-
plement, ressources disponibles de l’artiste
numérique.
• RGB (Red, Green, Blue ou, en français,

« Rouge, Vert, Bleu ») est le code utilisé par
défaut dans Blender.

• HSV : alternativement, vous pouvez employer
Hue, Saturation, Value (respectivement
teinte, saturation, valeur en français). Ce code
est très utilisé dans les logiciels de peinture ou
de retouche numérique (par exemple, Gimp).

• Hex : si vous connaissez une couleur par un
code hexadécimal, c’est ce code couleur qu’il
vous faut employer ; il est souvent employé par
les infographistes, par exemple lors de la défini-
tion des couleurs des éléments d’une page web.
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nous mettrons directement en œuvre celle qui nous intéresse : choisissez
Image Texture dans la colonne Texture.

Cliquez sur le bouton Open pour ouvrir le navigateur de Blender.
Déplacez-vous ensuite jusqu’à l’endroit où sont stockées vos textures
personnelles sur votre ordinateur (ou alors parcourez le DVD-Rom joint
à ce livre : Blender Texture Disk/texture/) et sélectionnez la texture de
votre choix (par exemple, boards3_vcyc.jpg dans le sous-répertoire
Blender Texture Disk/texture/wood/). Par défaut, Blender va vous pro-
poser les paramètres appropriés à ce type de surface :
• Color pour indiquer que Blender doit prendre en compte les informa-

tions de couleur de la texture ;
• Flat pour indiquer que la texture est projetée à plat sur la surface à

habiller ;
• Single Image lorsqu’il s’agit d’une simple image, par opposition à une

séquence d’images, un fichier vidéo ou une image générée de façon
procédurale.

Mais il reste le plus difficile à appréhender : la méthode selon laquelle
Blender doit manipuler cette image. C’est la fonction du champ Vector :
cliquez sur celui-ci et choisissez la méthode Mapping. Il vous est alors
possible de régler la position de la texture par rapport à l’objet (paramè-
tres Location), son orientation (paramètres Rotation) mais aussi son
échelle (paramètres Scale). Nous laisserons tous les paramètres par

Figure 3–53 Spécifier la couleur 
d’un objet est simple et intuitif.

Figure 3–54
Une texture vierge a été mise en place ; 

il ne reste plus qu’à la paramétrer !

Figure 3–55 La texture pour la table est 
désormais complète.
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défaut. En revanche, nous nous intéresserons à la nouvelle section Vector
qui vient désormais en complément de la première. Cliquez sur le
bouton sélecteur et choisissez cette fois l’option Generate.

Donner une texture à un objet fait partie des opérations de mise en cou-
leurs les plus complexes, mais également des plus courantes. Nous nous en
tiendrons là dans le cadre de cet exercice, mais sachez que Blender offre
une grande flexibilité dans le mélange de différentes textures et permet de
maîtriser l’application d’images sur des objets aux formes très complexes.
Ces notions seront abordées dans les autres chapitres de ce livre.

Donner à la carafe l’apparence du verre
Sélectionnez maintenant la carafe au premier plan, toujours avec le
bouton droit de la souris. De la même façon que précédemment,
assurez-vous d’être dans l’onglet Material de l’éditeur des propriétés, et
cliquez sur le bouton New pour ajouter un matériau dans la pile pour
l’instant vierge. Renommez ce dernier en quelque chose de plus expli-
cite, comme Verre.

Dans les paramètres de Surface, choisissez Glass BSDF. Il s’agit d’un
matériau prédéterminé de Blender qui restitue de façon réaliste le maté-
riau de verre, en mixant la juste proportion de transparence et de reflets.

Nous ne sommes pas obligés de toucher à ces paramètres, mais la pra-
tique sert à en comprendre les usages.
• Color vous permet de choisir la couleur du verre et donc d’obtenir des

effets très variés, entre le vert bouteille classique des bouteilles de vin

Figure 3–56
Notre scène commence à avoir de l’allure.

Figure 3–57
Le shader du verre est prêt !
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et la couleur pure et cristalline de l’eau. Ici, vous pouvez teinter le
verre de la carafe d’un très léger bleu-vert en choisissant, par
exemple, R0.97, G1.00 et B1.00.

• Roughness indique, comme précédemment, la rugosité du matériau et
donc la façon dont la lumière va « accrocher » sur les surfaces. Pour
une carafe en verre, extrêmement lisse, une valeur de 0.00 semble
pertinente.

• IOR représente l’indice de réfraction du matériau. Les matériaux
transparents, en fonction de leur densité, distordent la lumière qui
passe au travers. C’est pour cela que lorsque vous regardez au travers
d’un verre (ou de tout autre objet en verre aux surfaces courbes)
l’image est distordue.

Des cruchons en porcelaine, pour de légers effets 
de réflexion
Après avoir exploré les surfaces mates de type Diffuse BSDF, puis transpa-
rentes de type Glass BSDF, nous allons maintenant découvrir les maté-
riaux réflectifs. Sélectionnez l’un des cruchons en arrière-plan, et
souvenez-vous que ce sont des clones l’un de l’autre : les modifications
apportées à l’un se répercuteront à l’autre.

Dans l’onglet Material de l’éditeur de propriétés, la pile de matériaux est
vierge : cliquez sur le bouton New et renommez le nouveau matériau
Porcelaine_bleu.

Comme type de Surface, nous pourrions choisir Glossy BSDF, ce qui
devrait aboutir à la mise en place d’une surface parfaitement réflective.

BON À SAVOIR  
Quelques valeurs usuelles d’IOR

La valeur conventionnelle du verre est 1.44, celle
de l’eau est 1.33 et celle de l’air est 1.00. La
valeur par défaut proposée par Blender (1.45) est
donc tout à fait satisfaisante pour notre carafe.
L’annexe C propose une liste de valeurs appro-
chées d’indices de réfraction à destination de
l’artiste pressé.

Figure 3–58
Le rendu du verre est du plus bel effet, 
même dans la vue 3D.

BON À SAVOIR   
Miroir parfait et reflets flous

Si vous souhaitez mettre en place un miroir parfait,
utilisez un shader de type Glossy BSDF, et spéci-
fiez Sharp comme méthode de Distribution.
Color doit alors être un blanc pur, mais comme il
n’existe pas de miroir parfait dans la réalité, vous
spécifierez souvent un gris très léger à la place.
Deux méthodes de distribution, Beckmann et
GGX, permettent de troubler les reflets à la sur-
face de l’objet proportionnellement à la valeur
Roughness. Attention toutefois à ne pas abuser
de ce paramètre : aux alentours de 0.10 ou
0.15, l’image est considérablement floue et
nécessite des temps de calculs supplémentaires en
raison de l’échantillonnage de l’environnement
réalisé par le moteur de rendu Cycles.



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r 2

.6

© Groupe Eyrolles, 201386

C’est ce que vous rechercheriez pour un miroir ou du métal poli, par
exemple. Mais ce n’est pas exactement ce que nous souhaitons ici, car si
nous souhaitons effectivement que la porcelaine reflète son environne-
ment, ce devrait être dans une bien moindre mesure qu’un véritable
miroir. Nous allons donc voir comment mélanger deux shaders différents
et parfaitement doser l’effet de réflectivité souhaité.

Par conséquent, sélectionnez Mix Shader comme type de Surface. L’inter-
face donne désormais la possibilité de spécifier deux types de shaders
différents, et de les mélanger au travers du paramètre Fac (réglé par
défaut sur la valeur 0.5).

Pour le premier shader, mettez en place un simple Diffuse BSDF. Modifiez
son paramètre Color en cliquant sur le bandeau blanc et choisissez une
couleur bleue (ou autre !) de votre choix. Parce que nous souhaitons une
surface très lisse, vous pouvez laisser, en première approche, la valeur
Roughness à sa valeur par défaut 0.000.

Pour le second shader, choisissez Glossy BSDF, puis Sharp comme type de
Distribution à la place de Beckmann, et copiez la couleur du Diffuse BSDF
pour la coller dans celle du Glossy BSDF. Vous vous assurez ainsi que les
reflets sont teintés par la couleur de base de la porcelaine. En première
approche, vous pouvez spécifier une valeur nulle 0.000 à la valeur Rough-
ness de votre shader, mais vous souhaiterez peut-être que la porcelaine
présente un effet de surface qui trouble légèrement le reflet, auquel cas
vous pouvez expérimenter avec d’autres valeurs assez faibles, n’excédant
pas 0.200 par exemple.

Il ne vous reste plus qu’à spécifier la force d’influence de chaque shader.
Le paramètre Fac indique la part du second shader sur la surface de
l’objet. Avec une valeur de 0.000,  le second shader n’influe pas du tout
et laisse le premier shader s’exprimer pleinement. Avec une valeur de
1.000 en revanche, le second shader est le seul à influencer la surface de
l’objet, comme si le premier shader était désactivé. Si vous souhaitez, par
exemple, que la surface ne soit qu’à 45 % réflective, saisissez une valeur
Fac égale à 0.450.

ASTUCE   Copier-coller une couleur ou une valeur

Pour copier une couleur sans avoir à repasser par le nuancier ni avoir à ressaisir les compo-
santes R, G et B de celle-ci, il suffit de positionner le curseur de la souris au-dessus du ban-
deau de couleur source (inutile de cliquer) et d’employer la combinaison [Ctrl]+[C] pour en
copier le contenu. Positionnez ensuite le curseur de la souris au-dessus du bandeau de couleur
cible, et utilisez cette fois la combinaison [Ctrl]+[V] pour y coller la couleur précédemment
copiée. Cette astuce fonctionne également avec des valeurs numériques, tant que la nature
des valeurs source et cible est la même.

Figure 3–59
Mix Shader permet de définir indépendam-

ment deux shaders et de les mélanger propor-
tionnellement à la valeur du paramètre Fac.

Figure 3–60 Voici comment obtenir 
un matériau partiellement réflectif !
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Modifier l’arrière-plan et ajuster l’éclairage
Vous pourriez bien évidemment être amené à modéliser un arrière-plan
complet à votre scène : que ce soit un décor champêtre, évoquant un
pique-nique, ou un intérieur cosy au coin du feu, l’arrière-plan est très
certainement un élément à ne pas négliger.

Contrairement à tous les objets présents dans votre scène, qu’il s’agisse
d’éléments modélisés, de lampes ou de caméras, l’arrière-plan n’a pas
d’existence géométrique. On accède à ses paramètres au travers de
l’onglet World qui lui est dédié dans l’éditeur de propriétés. La scène par
défaut de Blender propose un arrière-plan gris d’une très grande neutra-
lité. Vous pouvez choisir une couleur alternative en cliquant sur le ban-
deau coloré du paramètre Color.

Vous pouvez bien évidemment vous en tenir là, par exemple dans le
cadre d’une présentation de produit, pour laquelle un arrière-plan uni est
suffisant. Mais dans le cas d’une scène qui se veut un petit peu plus éla-
borée, vous souhaiterez très certainement pousser le réalisme un peu plus
loin. Pour cela, cliquez sur le bouton Use Nodes, qui vous donnera accès à
des paramètres de réglages plus évolués.

Cliquez sur le bouton sélecteur à droite du paramètre Color et, dans le pan-
neau déroulant qui s’affiche, choisissez Image Texture. Cette option permet
de coller en fond de votre rendu une image que vous choisirez en cliquant
sur le bouton Open. Parcourez l’arborescence de votre système, et choisissez
l’image de votre choix (par exemple, Blender Texture Disc/texture/

building/wall/brickvariety_cyc.jpg qui se trouve sur le DVD-Rom qui
accompagne cet ouvrage). Choisissez maintenant un Vector d’affichage qui

Figure 3–61
La scène est modélisée et correctement mise en couleurs, 
il ne reste plus qu’à habiller l’arrière-plan !

Figure 3–62
Les paramètres World par défaut

Figure 3–63 Grâce au bouton Use Nodes, 
les paramètres du World ont désormais 
la même flexibilité que les matériaux.
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soit compatible avec vos intentions : ici, nous choisirons Window dans la
catégorie Texture Coordinate, car c’est la seule qui garantisse un affichage de
l’image en arrière-plan sans distorsion.

ASTUCE   Illumination ambiante : quelques cas de figure

• Scène intérieure, lumière totalement artificielle. Il s’agit, par
exemple, d’une pièce close, sans fenêtre permettant à une lumière
naturelle d’illuminer la scène : vous spécifierez une valeur
Strength très faible (de l’ordre de 0.200) et donnerez à l’inten-
sité de votre lampe une valeur très élevée, pour souligner un éclai-
rage artificiel avec très peu d’interréflexions lumineuses.
Idéalement, votre lampe sera de type Point.

Figure 3–64 Exemple d’éclairage totalement artificiel d’une scène 
d’intérieur 

• Scène intérieure, lumière naturelle. En raison des interré-
flexions lumineuses, la part de l’éclairage ambiant est plus pré-
pondérante et vous pouvez probablement utiliser une valeur
Strength pour le World de 0.600 environ. L’intensité d’éclairage
de la lampe est directement dépendante du scénario d’illumina-
tion que vous choisissez, mais on peut l’imaginer assez élevée.
Mais surtout, si vous voulez simuler l’éclairage d’une fenêtre
ouverte, privilégiez une lampe de type Area positionnée au niveau
de la fenêtre supposée.

Figure 3–65 Selon ce scénario, l’éclairage est plus riche et chaleu-
reux.

• Scène extérieure, lumière naturelle. Ce cas est très difficile à
gérer, car la valeur Strength dépendra essentiellement de la cou-
verture nuageuse que vous souhaitez simuler. Surtout, il vous
faudra choisir entre les lampes de types Sun et Hemi et choisir
celle qui donnera les résultats les plus pertinents pour votre scène,
surtout en ce qui concerne les ombres projetées par les objets : un
contexte nuageux conduit, par exemple, à des éclairages ambiants
très diffus et donc à des ombres très discrètes. Dans le cas d’un
ciel clair et dégagé, vous remplacerez avantageusement la couleur
d’arrière-plan par l’option Sky Texture.

Figure 3–66 Pour cette scène d’extérieur très lumineuse, il a fallu 
utiliser une lampe de type Hemi, aux dépens de la lampe de type 
Sun, afin d’obtenir des ombres portées satisfaisantes.
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Maintenant que nous avons un fond coloré qui habille notre scène,
essayons d’en modifier l’illumination afin qu’elle soit plus réaliste. En
effet, l’éclairage ambiant est tellement puissant que les ombres des
carafes sont difficiles à distinguer, voire invisibles. Il est manifestement
nécessaire de corriger l’éclairage ambiant, qui doit être plus discret, et de
renforcer la contribution de la lampe, au travers d’ombres plus tranchées.

BON À SAVOIR   Contrôler l’affichage de l’image en arrière-plan

Lorsque vous utilisez l’option Image Texture, l’image choisie est
plaquée en arrière-plan de la vue 3D. C’est donc celle-ci qui va impli-
citement déterminer les proportions de l’image et sa position par
rapport à la vue de caméra (touche [0] du pavé numérique). Vous
aurez toutefois souvent besoin de décaler en X et/ou en Y votre
image d’arrière-plan, voire de l’agrandir ou de la diminuer pour
simuler un positionnement à une certaine distance de la scène.
Si vous choisissez Mapping comme option pour le paramètre
Vector, des paramètres Location, Rotation et Scale s’affichent.
Vous noterez également l’apparition d’un second paramètre
Vector, avec l’habituel bouton point sur la droite. Cliquez sur
celui-ci, et, comme dans l’exercice, choisissez Window et choi-
sissez une image dans votre bibliothèque. Vous pouvez mainte-
nant jouer sur les paramètres du VectorMapping pour zoomer,
dézoomer, décaler, voire faire tourner l’image de fond sur elle-
même, à volonté.

Figure 3–67
La mise en place d’une simple image en arrière-plan

se réalise en quelques actions de souris à peine.

Figure 3–68
Et voilà notre scène avec un joli arrière-plan ! Malheureusement 
les ombres des objets sur la table sont à peine visibles.
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Tout d’abord, dans l’onglet World, diminuez le paramètre Strength à une
valeur plus modeste, comme 0.050. L’image de fond, dans ce cas-là, ne con-
tribue plus que de façon marginale à l’éclairage ambiant et l’on peut consi-
dérer que cette contribution se limite aux rebonds de la lumière sur les murs
et plafonds, permettant de déboucher les ombres qui autrement auraient été
plus pleines et plus opaques si le paramètre Strength avait été réglé sur 0.000,
ou à la limite de l’inexistence s’il avait été réglé sur 1.000 ou plus.

Dans l’une des vues 3D, sélectionnez la lampe avec le bouton droit de la
souris. Dans l’éditeur des propriétés, affichez l’onglet Object Data et cliquez
sur le bouton Use Nodes afin de débloquer la personnalisation des paramè-
tres de la lampe. Le type de lampe présélectionné est Point ; c’est une source
lumineuse ponctuelle, dont les rayons de lumière vont irradier dans toutes
les directions à la fois, ce qui est parfait pour simuler une ampoule.

L’intensité de l’éclairage n’est toutefois pas exceptionnelle : augmentez le
paramètre Strength aux alentours de 10000.000, en fonction de la puis-
sance que vous souhaitez donner à l’éclairage artificiel.

Justement, s’agissant d’une source de lumière artificielle, il conviendra de
changer la couleur de la lumière émise par la lampe. Par exemple, en
supposant qu’il s’agit d’une ampoule de faible puissance, nous lui donne-
rons une couleur orangée en cliquant sur le bandeau coloré du paramètre
Color. Plutôt que de choisir une couleur dans le nuancier, saisissez direc-
tement les valeurs suivantes R1.000, G0.773 et B0.561, ce qui devrait cor-
respondre à l’éclairage légèrement orangé apporté par une ampoule
classique de 40 W de puissance.

BON À SAVOIR   La couleur des sources lumineuses

La couleur de la lumière émise dépend de plusieurs facteurs, parmi lesquels la température
(généralement exprimée en Kelvin) de cette source ainsi que sa nature. L’œil humain parvient
de façon innée à corriger la « balance des blancs » de son environnement, mais les lumières
incandescentes de notre environnement tirent en vérité vers la couleur orange, la lumière du
jour vers le bleu, etc. Voici quelques valeurs R, G, B à utiliser comme point de départ, mais
pensez à toujours les ajuster en fonction de l’effet visuel recherché.

• Bougie (1 900 K) : 1.000, 0.576, 0.004
• Ampoule 40 W au tungstène (2 600 K) : 1.000, 0.773, 0.561
• Ampoule 100 W au tungstène (2 850 K) : 1.000, 0.839, 0.667
• Halogène (3 200 K) : 1.000, 0.945, 0.878
• Soleil au zénith (5 400 K) : 1.000, 1.000, 0.984
• Rayon de soleil direct (6 000 K) : 1.000, 1.000, 1.000
• Ciel nuageux (7 000 K) : 0.788, 0.886, 1.000
• Ciel bleu clair (20 000 K) : 0.251, 0.612, 1.000

Figure 3–69

Figure 3–70
La lampe émet une lumière légèrement 

orangée et l’intensité de celle-ci est ajustée 
en fonction des besoins de la scène.



3 
– 

Pr
em

ie
r p

ro
je

t a
ve

c 
Bl

en
de

r

© Groupe Eyrolles, 2013 91

Étalonnage des couleurs et rendu final
Il s’agit là de procéder à l’altération ou à l’amélioration des couleurs d’une
image ou d’une séquence d’images, manipulation également employée pour
renforcer une ambiance ou une couleur particulière. Il s’agissait autrefois
d’une manipulation chimique en laboratoire sur les pellicules de films, mais
le procédé est désormais appliqué numériquement, ce que Blender sait faire
de façon native, soit en utilisant l’éditeur de nœuds, soit en jouant avec les
options de gestion de la couleur de l’onglet Scene.

L’un des emplois les plus basiques consiste à corriger le contraste en agis-
sant sur les trois champs lumineux de l’image : les ombres, les tons moyens
et les hautes lumières, ceci afin de créer des images plus intéressantes.

Ce sont des opérations de post-traitement, qui ne pourront donc pas
s’afficher dans la vue 3D en mode Rendered. Transformez l’une de vos
vues 3D en éditeur UV/Image et effectuez un rendu grâce à la
touche [F12] ou en passant par le menu Render>Render Image. Lorsque
c’est fait, dans la section Color Management de l’onglet Scene, cochez
l’option Use Curves pour afficher la courbe de correction. Toutes les
modifications que vous apporterez à l’étalonnage de couleurs seront alors
reportées sur l’image rendue, vous permettant de fixer très rapidement
les réglages qui vous conviennent.

Par défaut, le bouton C est actif, indiquant que la courbe va influer sur le
contraste de l’image. L’expérimentation révèle rapidement que la partie
la plus à gauche influe sur les ombres, celle médiane sur les tons moyens
et celle à droite sur les hautes lumières de votre image.

Figure 3–71
Félicitations, notre scène est désormais complète !

Figure 3–72 Le panneau de gestion 
de la couleur de Blender
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Par exemple, pour les ombres, l’espace situé dans la partie supérieure du
graphe est plus lumineux et celui situé dans la partie inférieure, plus
sombre. Pour comprendre comment cela fonctionne, rien de plus simple
que l’expérimentation !

Pour ajouter et manipuler des points, il suffit de cliquer avec le bouton
gauche de la souris sur la courbe, à l’endroit où le point doit apparaître.
Créez-en un au milieu de chaque zone. Déplacez ensuite chaque point
soit vers le haut, soit vers le bas, selon que vous souhaitez éclaircir ou
assombrir chacune des trois zones. Généralement, façonner une courbe
en « S » permet de contrôler assez précisément le contraste de l’image.

Prenez toutefois garde à progresser par petites touches subtiles, afin de
conserver une cohérence lumineuse à votre image. Il est également pos-

Figure 3–73
Les trois zones de la courbe de couleur

Figure 3–74
Avec un peu de pratique, corriger le contraste

de l’image rendue se révèle une formalité.



3 
– 

Pr
em

ie
r p

ro
je

t a
ve

c 
Bl

en
de

r

© Groupe Eyrolles, 2013 93

sible de modifier drastiquement la tonalité d’une image grâce à ces
mêmes courbes d’étalonnage. En effet, plutôt que d’agir sur le contraste,
avec l’option C active, vous pouvez choisir un canal de couleur particulier
parmi R (Red, rouge), G (Green, vert) ou B (Blue, bleu). Par exemple, en
choisissant R, vous pouvez renforcer très légèrement la composante
rouge de votre scène de sorte que l’image paraisse plus chaleureuse.

Au contraire, en diminuant volontairement la composante rouge (R) et
en renforçant un peu les composantes verte (G) et bleue (B), il est pos-
sible de créer une ambiance beaucoup plus glaciale (bleu) et légèrement
surnaturelle (vert).

Pour le rendu final de votre projet, vous prendrez le soin de laisser Blender
calculer l’image aussi longtemps que vous pourrez vous le permettre, en

Figure 3–75
La composante R permet, par exemple, de 
simuler plus fidèlement l’éclairage au feu de 
cheminée.

BON À SAVOIR  
Pourquoi étalonner ses couleurs ?

Lorsque vous créez une image avec Blender, les
couleurs peuvent véritablement être une aide à la
narration, permettant aux images de véhiculer des
ambiances, des sensations ou encore des senti-
ments.
Par conséquent, l’étalonnage des couleurs est une
étape à ne pas négliger, d’autant qu’avec assez
peu de pratique, il est parfois possible de transfi-
gurer des images terriblement ordinaires.

Figure 3–76
A contrario, créer une ambiance glaciale et 
dérangeante est tout aussi aisé, en jouant sur 
toutes les composantes à la fois.
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fonction des capacités de calcul de votre ordinateur. Pour cela, rendez-vous
dans l’onglet Render de l’éditeur des propriétés. Dans la partie Sampling,
augmentez la valeur Samples pour Render à une valeur élevée : 32 ou 68
pour des ordinateurs peu puissants ou si vous avez peu de temps, 128 ou 256
pour des ordinateurs puissants ou si avez du temps devant vous, 512 ou plus
si vous avez à la fois du temps et un ordinateur puissant.

Si vous ne connaissez pas encore les aptitudes de votre ordinateur, nous
vous recommandons bien sûr de commencer avec une valeur modeste,
proche de 32. Sachez toutefois que plus vous utilisez d’échantillons Sam-
ples, moins vous aurez de grain ou de « bruit » sur votre image finale, et
que plus les reflets caustiques (dans l’ombre de la carafe en verre) seront
de qualité satisfaisante.

Lancez le rendu via la touche [F12] ou le menu Render>Render Image.
Une fois l’image entièrement calculée, enregistrez-la précieusement
grâce à la touche [F3] ou, dans l’en-tête de l’éditeur UV/Image, grâce au
menu Image>Save As Image.

Figure 3–77
Le réglage du nombre d’échantillons Samples 
pertinent dépend à la fois de votre patience et 
de la puissance de calcul de votre ordinateur.

ASTUCE   Se débarrasser des étincelles indésirables

Lorsque vous utilisez des shaders de type Glass BSDF ou Glossy BSDF, et que le nombre
d’échantillons Samples lors du rendu est suffisamment élevé (communément, au-dessus de
10), des points blancs apparaissent parfois sur vos rendus finaux, qui persistent quel que soit
le temps passé à effectuer le rendu avec des valeurs de Samples élevées. Ce sont en fait des
points auquel le moteur de rendu Cycles confère une brillance qui va au-delà de la couleur
blanche. Ces points blancs sont appelés, en anglais, fireflies (littéralement, « lucioles ») ou
« étincelles » en français. C’est un phénomène bien connu, souvent éliminé avec un logiciel de
retouche d’image comme Gimp.
Pour supprimer ces étincelles, dans l’éditeur des propriétés, vous pouvez utiliser la valeur
Clamp des paramètres Sampling de l’onglet Render. Généralement, une valeur comprise
entre 1.000 et 2.000 fera l’affaire.

Figure 3–78
Exemples d’étincelles indésirables qui apparaissent au cours du rendu.
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Figure 3–79 Félicitations, vous avez terminé votre premier projet et déjà beaucoup appris sur Blender !
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annexeA
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Les raccourcis clavier de Blender

L’apparente complexité de Blender est en partie due à la 
multiplicité des raccourcis clavier existants. Si des progrès ont 
été accomplis au niveau de l’interface, ce qui permet de réaliser 
la plupart des actions à la souris ou au travers de boutons et de 
menus, force est de constater que l’utilisateur ne parvient à 
devenir réellement productif que par l’usage intensif des 
raccourcis clavier.
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Il est possible d’accéder à une liste assez complète (en anglais) des rac-
courcis clavier disponibles au travers de l’onglet Input dans la fenêtre
Users Preferences accessible par le raccourci [Ctrl]+[Alt]+[U] ou par le
menu File>User Preferences… Il s’agit d’un menu visant l’exhaustivité qui
permet d’afficher, par catégorie, tous les raccourcis clavier. Ce menu
vous offre la possibilité de créer vos propres raccourcis. Les utilisateurs
de Maya pourront trouver avec joie tous les raccourcis paramétrés selon
leurs habitudes en changeant Blender pour Maya dans le menu déroulant
situé en haut de l’onglet Input. Dans tous les cas, ne vous effrayez pas au
survol de cette aide, et rassurez-vous en vous disant que l’auteur de cet
ouvrage ne doit en maîtriser au quotidien que 15 à 20 %.

C’est pour cela que cette annexe a pour but d’attirer votre attention sur
les raccourcis les plus essentiels (du point de vue de l’auteur) et vous sug-
gère des références mnémotechniques pour vous aider à les retenir.

Figure A-1
La liste des raccourcis clavier

vous permettra d’automatiser
de nombreuses opérations

et et vous aidera à progresser
dans la maîtrise de Blender.

© 2013, Robot par Henri Hebeisen
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La souris
La souris est indissociable du fonctionnement de Blender. Un usage appro-
prié de celle-ci évite à l’utilisateur bien des allers-retours du pointeur à
l’écran. En particulier, elle permet de contrôler la vue 3D, de sélectionner et
désélectionner des objets, de confirmer ou d’annuler des opérations.

Manipulations de base

Manipulations courantes

Transformations

Raccourci Contexte Description Pense-bête

[bouton gauche] Positionne le curseur dans la vue 3D.

[bouton central] Fait tourner la vue autour d’un axe perpendiculaire à 
l’écran.

[Ctrl]+[bouton central] Zoome dans la vue, pratique en absence de molette.

[Maj]+[bouton central] Déplace la vue.

[bouton droit] Sélectionne un objet ou un élément.

[Maj]+[bouton droit] Ajoute ou enlève à la sélection des objets ou des élé-
ments supplémentaires.

[molette] Zoome dans la vue.

Raccourci Contexte Description Pense-bête

[Ctrl]+bouton gauche En fonction du mode, permet d’extruder un sommet, 
une arête ou une face (mode Edit), une clé (éditeur de 
graphes), un os à l’armature (mode Edit d’armature).

[Ctrl]+[Alt]+bouton droit Edit Sélectionne une boucle d’arêtes (edge-loop) ou de 
facettes (face-loop).

Raccourci Contexte Description Pense-bête

[Ctrl], déplacement pointeur Transforme (déplacement, rotation, mise à échelle) par 
incréments réglés.

[Ctrl]+[Maj], déplacement 
pointeur

Transforme (déplacement, rotation, mise à échelle) par 
incréments plus fins.

[bouton gauche] Met fin à l’action en l’acceptant.

[bouton central] Bascule d’un axe de transformation à l’autre.

[bouton droit] Met fin à l’action en l’annulant.
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Le clavier
Blender est un logiciel aux fonctionnalités très riches, dont les possibi-
lités peuvent aisément se dissimuler dans des strates diverses de menu.
Presque toutes les fonctions peuvent être appelées rapidement d’une
simple combinaison au clavier. Certes, retenir toutes les combinaisons
est une gageure, mais cette annexe est justement là pour vous donner les
clés essentielles.

Touches de fonction
Elles permettent de réaliser les fonctions les plus courantes de Blender
(ouvrir un fichier ou l’enregistrer) ou encore de basculer rapidement dans
le menu de boutons de votre choix.

Les raccourcis clavier
Un même raccourci clavier peut servir à différentes fonctions, selon le
type de vue (vue 3D, éditeur d’UV/Image, éditeur de graphes, etc.) ou le
mode (Edit, Pose, Vertex Paint, etc.). Généralement, une fonction particu-
lière est attachée à une lettre, et les variantes de cette fonction attachées
à une combinaison à base des touches [Maj], [Ctrl] ou [Alt]. Lorsque cela
est possible ou pertinent, les tableaux ci-après précisent les principaux
modes (ou vues) de fonctionnement ainsi qu’une astuce mnémotech-

Raccourci Contexte Description Pense-bête

[F1] Ouvre un fichier dans Blender.

[Maj]+[F1] Importe la librairie de données (Append).

[F2] Sauvegarde le fichier.

[F3] Sauvegarde l’image rendue.

[Ctrl]+[F3] Capture la vue 3D et la sauvegarde.

[Alt]+[F3] Capture une vidéo de l’écran et la sauvegarde. Il est 
judicieux de choisir un format vidéo de sortie dans les 
options du menu Render.

[F11] Affiche le dernier rendu effectué.

[Ctrl]+[F11] Lit le dernier rendu d’animation effectué.

[Alt]+[F11] Affiche Blender en plein écran.

[F12] Calcule le rendu de la frame courante.

[Ctrl]+F12] Calcule le rendu de l’animation.
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nique pour aider à retenir le raccourci. Souvent, le raccourci est baptisé
d’une initiale ou d’une lettre significative de la fonction attachée.

Les touches d’usage général
Ce sont les raccourcis de base que vous gagnerez à maîtriser, tant ils sont
régulièrement invoqués.

Raccourci Contexte Description Pense-bête

[Espace] Tous Invoque le menu de recherche des fonctions possibles 
dans la fenêtre.

[Tab] Tous Entre/sort du mode Edit fonctionne pour divers modes 
et types de fenêtres.

[Maj]+[A] Tous Invoque le menu Add pour ajouter un élément [A]dd, [A]jouter

[A] Tous Sélectionne/désélectionne tous les éléments de la vue 
3D.

[A]ll, tout

[Alt]+[A] Joue l’animation dans toutes les vues 3D. [A]nimation

[Ctrl]+[A] Object, Edit, 
Pose

Applique l’échelle et les rotations de l’objet à son bloc 
de données.

[A]pplique

[B] Tous Sélection par boîte ; la boîte est tracée par la souris : il 
s’agit d’une boîte de sélection ([bouton gauche]) ou 
de désélection ([bouton droit]).

[B]oîte

[C] Object, Edit, 
Pose

Sélection par cercle ; le cercle est tracé par la souris : il 
s’agit d’une boîte de sélection ([bouton gauche]) ou 
de désélection ([bouton droit]). Rayon modifiable 
avec la molette.

[C]ercle

[G] Tous Déplace la sélection dans le plan de la vue 3D. [G]rab, attraper pour déplacer

[Crtl]+[I] Object, Edit, 
Pose

Inverse la sélection. [I]nverser la sélection

[N] Tous Invoque/révoque le panneau flottant Properties 
adapté au type de vue.

Panneau flottant [N]umérique

[P] Vue 3D Démarre le moteur de jeu. [P]lay, jouer, moteur de jeu

[Alt]+[P] Éditeur de texte Exécute le script courant (script Python non distribué 
avec Blender ou ne pouvant intégrer le menu Scripts).

[P]lay script, jouer un script

[Ctrl]+[Q] Tous Quitte Blender. [Q]uitter

[R] Object, Edit, 
Pose

Rotation de la sélection autour d’un axe perpendiculaire 
à l’écran.

[R]otation

[S] Object, Edit, 
Pose, 
DopeSheet

Redimensionne la sélection. [S]cale ou [S]ize, dimension

[Maj]+[S] Vue 3D Invoque le menu Snap et affiche ses options. [S]nap, accrochage

[Ctrl]+[Z] Tous Annule la dernière action effectuée.
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Les touches utiles en mode Object
Nous avons ici essayé de retenir les plus communes des fonctions asso-
ciées au mode Object, dans la vue 3D (certaines fonctionnent presque de
la même façon dans d’autres types de vue). En effet, le mode Object est
probablement celui auquel vous accorderez le plus de temps, avec le
mode Edit. Nous allons donc lui accorder une attention particulière.

[Maj]+[Ctrl]+[Z] Tous Restaure la dernière opération annulée.

[Ctrl]+[U] Tous Sauvegarde la scène/écran courant comme étant la 
scène/écran de démarrage par défaut.

[U]ser default settings, paramètres 
par défaut de l’[U]tilisateur

[X] Tous Supprime la sélection.

[Ctrl]+[N] Tous sauf Edit Réinitialise la scène ; elle est alors remplacée par la 
scène de démarrage par défaut.

[N]ew, [N]ouvelle scène

Raccourci Contexte Description Pense-bête

Raccourci Contexte Description Pense-bête

[Alt]+[C] Object Invoque le menu Convert et affiche ses options. [C]onvertit

[Alt]+[D] Object Crée une nouvelle instance (clone) de la sélection. [D]upliquata

[Maj]+[D] Object Crée une copie de la sélection. [D]uplicata

[Alt]+[G] Object Remet à zéro les déplacements de l’objet.

[Maj]+[Alt]+[G] Object Enlève les objets sélectionnés des groupes les conte-
nant.

[G]roupe

[Ctrl]+[G] Object Ajoute les objets sélectionnés à un groupe. [G]roupe

[I] Object, vue 3D Invoque le menu Insert Key et affiche ses options. [I]nsère

[Alt]+[I] Object, vue 3D Enlève la clé d’animation de l’objet sélectionné sur la 
frame courante.

[Ctrl]+[ J] Object Joint les maillages des objets sélectionnés. [J]oint

[M] Object Déplace la sélection sur un autre calque. [M]ove to layer, déplacer sur un 
calque

[Ctrl]+[M] Object Initie une transformation miroir. Un axe (X,Y ou Z) doit 
ensuite être choisi.

[M]iroir

[Alt]+[P] Object Supprime les relations parent existantes de la sélection. [P]arent

[Ctrl]+[P] Object, 
Armature

Fait de l’objet actif le parent d’un autre objet également 
sélectionné.

[P]arent

[Alt]+[R] Object Remet à zéro les rotations de la sélection. [R]otation

[Alt]+[S] Object, Pose Remet à zéro l’échelle de la sélection. [S]ize, dimension

[Alt]+[T] Object Remet à zéro le pistage d’un objet par la sélection. [T]racking, suivre, pister
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Les touches utiles en mode Edit
À l’instar des raccourcis du mode Object, l’usage des touches suivantes,
en mode Edit, vous fera gagner un temps énorme en évitant les va-et-
vient incessants avec la souris depuis la vue 3D jusqu’aux divers menus et
boutons. Certaines de ces touches et combinaison fonctionnent aussi
bien pour l’édition des maillages que celles d’autres objets, comme les os
et armatures, par exemple, même si l’accent est mis sur les maillages.

[Ctrl]+[T] Object Oblige la sélection à pister l’objet actif, également sélec-
tionné.

[T]racking, suivre, pister

[U] Object Invoque le menu Make Single User et affiche ses 
options.

[U]tilisateur unique

[Ctrl]+[Alt]+[Z] Edit, Object Invoque le menu Global Undo History pour afficher 
l’historique des dernières actions.

Raccourci Contexte Description Pense-bête

Raccourci Contexte Description Pense-bête

[Numpad–] 
ou [Numpad+], 
molette de la souris

Edit Lors d’une transformation avec PET ou lors d’une sélec-
tion circulaire, diminue ou augmente le rayon.

[C] Edit Active la sélection circulaire. [C]ercle

[E] Edit Extrude la sélection. [E]xtrusion

[Ctrl]+[E] Edit Invoque le menu Edge Specials et affiche ses options. [E]dge, arête

[Maj]+[E] Edit Règle la dureté (Crease) des arêtes. [E]dge, arête

[F] Edit Crée une arête ou une facette à partir des sommets 
sélectionnés.

[F]acette

[Alt]+[F] Edit Remplit avec des facettes à partir des sommets ou des 
arêtes sélectionnées.

[F]ill, remplit de facettes

[H] Edit, Object, 
Sculpt

Masque la sélection. [H]ide, cacher

[Alt]+[H] Edit, Object, 
Sculpt

Réactive l’affichage de la sélection masquée. [H]ide, cacher

[Ctrl]+[H] Edit Invoque le menu Hooks pour ajouter un crochet aux 
sommets sélectionnés.

[H]ook, crochet

[Alt]+[ J] Edit Joint les triangles partageant une arête pour former des 
quadrangles.

[J]oint

[K] Edit Fait apparaître le couteau pour procéder à des découpes 
de votre maillage.

[K]nife, couteau

[L] Edit Sélectionne tous les sommets liés situés sous le pointeur 
de la souris (ne pas cliquer avec la souris, seulement la 
positionner).

[L]iés
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Les touches utiles en mode Sculpt
Sans être essentiels, ces raccourcis simplifient considérablement la vie
des sculpteurs.

[Ctrl]+[L] Edit Sélectionne tous les sommets liés à ceux déjà 
sélectionnés.

[L]iés

[Ctrl]+[M] Edit Initie une transformation miroir. Un axe (X,Y ou Z) doit 
ensuite être choisi.

[M]iroir

[Alt]+[M] Edit Invoque le menu Merge et affiche ses options. [M]erge, fusionne

[Ctrl]+[N] Edit Recalcule les normales vers l’extérieur. [N]ormales

[Ctrl]+[Maj]+[N] Edit Recalcule les normales vers l’intérieur. [N]ormales

[O] Edit, éditeur 
UV/Image

Active/désactive l’outil d’édition proportionnelle (PET). Édition pr[O]portionnelle

[P] Edit Sépare les sommets sélectionnés du maillage courant et 
crée un nouvel objet à partir de ceux-ci.

Sé[P]are

[Ctrl]+[P] Edit Fait du sommet actif le parent de l’objet sélectionné. [P]arent

[Ctrl]+[R] Edit Active l’outil Loopcut.

[Alt]+[S] Edit Active l’outil Shrink/Flatten. [S]hrink/Flatten, rétrécir/aplatir

[Ctrl]+[T] Edit Transforme des quadrangles en triangles. [T]riangles

[W] Edit Invoque le menu Specials et affiche ses options.

[X] Edit Invoque le menu Delete et affiche ses options.

[Y] Edit Désolidarise la sélection du reste du maillage, mais la 
conserve à l’intérieur de celui-ci.

Raccourci Contexte Description Pense-bête

Raccourci Contexte Description Pense-bête

[Ctrl]+bouton gauche Sculpt Maintenir pressée cette touche pour passer du mode 
Add au mode Subtract.

[PageUp] ou 
[PageDown]

Sculpt Affiche le niveau de résolution immédiatement supé-
rieur ou immédiatement inférieur.

[A], [D], [G], [I], [L], 
[P], [S]

Sculpt Invoquent les différents types de brosse : Airbrush, 
Draw, Grab, Inflate, Layer, Pinch, Smooth.

[A]irbrush, [G]rab, [I]nflate, [L]ayer, 
[P]inch, [S]mooth

[F] Sculpt, vue 3D Redimensionne la brosse.

[Maj]+[F] Sculpt Modifie la valeur Strength de la brosse. [F]orce

[H] Sculpt Permet de sélectionner une zone à masquer. [H]ide, cacher

[Alt]+[H] Sculpt Affiche la sélection masquée. [H]ide, cacher
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Les touches utiles en animation
L’animation est un domaine très vaste, regroupant des ensembles d’outils
très différents et parfois obscurs : F-Curves, armatures, éditeurs
d’action, etc. S’il est possible de recenser tous les raccourcis claviers rela-
tifs, il est aussi très facile de s’y perdre. Nous n’avons sélectionné que
ceux qui sont vraiment très utiles.

Les touches utiles pour le dépliage UV
Il est possible de se passer du calcul des UV pour vos textures, mais
lorsque vous commencez à vous y intéresser, vous remarquez vite qu’un
bon dépliage autorise toujours un meilleur contrôle de la texture. Quel-
ques raccourcis de base aident alors à démarrer cette activité.

Raccourci Contexte Description Pense-bête

[Gauche] ou [Droite] Se déplace d’une frame en arrière ou en avant.

[Maj]+[Bas] ou 
[Maj]+[Haut]

Se déplace de 10 frames en arrière ou en avant.

[Bas] ou [Haut] Se déplace jusqu’à la prochaine frame contenant une 
clé d’animation pour l’objet actif.

[Maj]+[Gauche] ou 
[Maj]+[Droite]

Recule jusqu’à la première frame ou avance jusqu’à la 
dernière frame.

[Maj]+[Ctrl]+[C] Armature En mode Pose, ajoute une contrainte à un nouvel objet 
Empty.

[C]ontrainte

[T] Éditeur de courbe 
IPO

Change le type d’interpolation d’une courbe IPO. in[T]erpolation [T]ype, [T]ype 
d’in[T]erpolation

Raccourci Contexte Description Pense-bête

[L] UV Face Select Sélectionne les facettes liées ensemble. [L]iées

[P] Éditeur 
UV/Image

Cloue sur place les UV sélectionnées. [P]in, cloue

[Alt]+[P] Éditeur 
UV/Image

Décloue les UV sélectionnées. [P]in, cloue

[W] Éditeur 
UV/Image

Invoque le menu Weld/Align et affiche ses options. [W]eld, soude, fusion
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Les touches relatives à l’affichage
Maîtriser l’affichage dans votre espace de travail est la première étape
vers la maîtrise de vos outils. Blender est fidèle à sa réputation de versa-
tilité. Les raccourcis qui suivent sont nombreux (il y en a pourtant bien
d’autres !) mais tous sont utiles au quotidien.

Raccourci Contexte Description Pense-bête

[Home] Affiche tous les éléments de la scène.

[Ctrl]+[Bas] ou 
[Ctrl]+[Haut]

Minimise/maximise la vue dans laquelle se trouve le 
pointeur de la souris.

[.] du pavé numérique Vue 3D Centre la vue active sur un objet sélectionné et zoome 
sur lui.

[Alt]+[B] Object Définit une portion de l’espace 3D visible grâce à une 
boîte de sélection.

[B]oîte

[Maj]+[C] Vue 3D Recentre la vue active sur un objet et place le curseur 
3D à l’origine du repère Global.

[C]entre

[H] Object, Edit Masque les objets ou les sommets sélectionnés, en fonc-
tion du mode.

[H]ide, cache, dissimule, masque

[Alt]+[H] Object, Edit Révèle les objets ou les sommets masqués, en fonction 
du mode.

[H]ide, cache, dissimule, masque

[Maj]+[H] Edit Masque les sommets et les faces désélectionnés. [H]ide, cache, dissimule, masque

[Z] Vue 3D Passe de l’affichage solide à l’affichage fil de fer.

[Alt]+[Z] Vue 3D Passe de l’affichage solide à l’affichage texturé.

[Suppr] Vue 3D Zoome sur l’objet sélectionné.

[/] Vue 3D Vue locale sur l’objet sélectionné (les autres objets sont 
masqués).

[+] ou [-] Vue 3D Zoome en avant ou en arrière.

[0] Vue 3D Vue de la caméra.

[Ctrl]+[0] Vue 3D Définit l’objet actif comme étant la caméra.

[Ctrl]+[Alt]+[0] Vue 3D Aligne la caméra active sur la vue.

[1] ou [Ctrl]+[1] Vue 3D Vue de face ou de derrière.

[3] ou [Ctrl]+[3] Vue 3D Vue de droite ou de gauche.

[7] ou [Ctrl]+[7] Vue 3D Vue de dessus ou de dessous.

[5] Vue 3D Bascule de la vue perspective à la vue orthogonale.

[4] ou [6] Vue 3D Fait tourner la vue à gauche ou à droite.

[Ctrl]+[4] ou [Ctrl]+[6] Vue 3D Décale la vue vers la gauche ou la droite.

[8] ou [2] Vue 3D Fait tourner la vue vers le haut ou vers le bas.

[Ctrl]+[8] ou [Ctrl]+[2] Vue 3D Décale la vue vers le haut ou le bas.
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Les touches relatives au rendu
Le rendu est l’étape obligée de toute œuvre en image de synthèse.
L’essentiel des raccourcis se trouve ci-dessous, mais il y en a d’autres.

Raccourci Contexte Description Pense-bête

[F11] Rappelle la dernière image rendue.

[Ctrl]+[F11] Lit le dernier rendu d’animation effectué.

[F12] Effectue le rendu de la frame courante.

[Ctrl]+F12] Calcule le rendu de l’animation.

[Maj]+[B] Définit les frontières du rendu (dans la vue de la caméra 
active).

[B]ounding, frontière
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annexeB

© 2012, Modélisation d’une C4 coupé VTS par Damien Monteillard (http://www.3dminfographie.com/portfolio.php)
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Les add-ons de Blender

Blender est livré en standard avec un certain nombre 
d’add-ons, des scripts écrits en Python permettant de rendre 
des services dans des domaines très variés, à l’instar 
des plug-ins d’autres applications commerciales, comme 
3ds Max ou Maya. La différence est que ces add-ons sont 
intégrés à Blender tel que vous le téléchargez : pas besoin 
de les acquérir et de les installer séparément.

Le chapitre 1 « Installation de Blender » explique comment 
accéder et activer un add-on en particulier. Dès lors, celui-ci sera 
accessible lors de la session de travail au travers du menu 
approprié, comme s’il s’agissait d’une fonction native de Blender.

Les add-ons livrés en standard avec Blender ne nécessitent pas 
l’installation de Python sur votre ordinateur. En revanche, 
certains autres scripts que l’on peut trouvé sur Internet, 
développés par des contributeurs de la communauté, 
nécessitent qu’une version complète du langage de 
programmation Python soit installée. Le cas échéant, un 
message d’erreur dans la console ou la fenêtre de commandes 
MS-DOS vous en informera, et l’installation de Python sera 
alors indispensable pour faire usage du script en question.
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3D View
3D Navigation : un émulateur de pavé numérique virtuel placé dans l’éta-
gère à outils [T], idéal pour les ordinateurs portables ou les claviers sans
pavé numérique.

Copy Attributes Menu : fonctionne sur une sélection d’objets ou d’os d’arma-
ture. [Ctrl]+[C] permet de copier les attributs de l’objet actif de la sélection,
et de cascader ceux-ci au reste de la sélection au moyen d’un menu.

Dynamic Spacebar Menu : permet d’associer à la touche [Espace] un menu
dynamique donnant un accès rapide à de nombreux outils disséminés
dans les autres menus traditionnels. Le menu prend en compte le con-
texte (mode Object, Edit, Pose, etc.) ainsi que le type d’objet afin de pro-
poser ses options.

Math Vis (Console) : permet de visualiser dans la vue 3D les variables
Python mathutils définies dans la console, pour faciliter la compréhen-
sion de matrices de transformation complexes, des conversions de rota-
tions, des intersections de rayons, etc., au moyen de vecteurs, points et
matrices. Spécialement dédié aux créateurs d’add-ons.

Measure Panel : le menu de cet add-on se cache dans le panneau
numérique [N]. Il permet d’ajouter une ligne entre deux points, qu’il
s’agisse de deux objets sélectionnés, ou un objet et le curseur, et d’affi-
cher dans la vue 3D comme dans le panneau la distance, en unités de
Blender.

Screencast Keys : un script idéal pour les auteurs de tutoriels vidéo ou les
animateurs de formations. Dans le panneau numérique [N], section
Screencast Keys ou grâce à la combinaison [Maj]+[Alt]+[C], vous autorisez
l’affichage dans le coin inférieur gauche de la vue 3D des touches et
combinaisons de touches que vous utilisez.

Add Curve
Extra Objects : met à disposition de nouvelles primitives complexes : des
spirales, des nœuds toriques ou encore une panoplie d’objets de type
Curve. Toutes ces primitives très mathématiques sont disponibles via le
menu Add>Curve ou la combinaison [Maj]+[A].

IvyGen : permet de « faire pousser » du lierre sur un objet maillé sélec-
tionné, et à partir du curseur 3D, à partir du menu Add>Curve ou via la
combinaison [Maj]+[A]. Une fois généré, le lierre peut être paramétré
dans l’étagère à outils [T].
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Sapling : permet de générer une grande variété d’arbres réalistes via le
menu Add>Curve ou la combinaison [Maj]+[A]. Une fois généré, l’arbre
peut être paramétré dans l’étagère à outils [T].

Simplify Curves : permet de simplifier des objets de type Curve ou des F-
Curves dans l’éditeur Graph (les contrôles se trouvent dans l’étagère à
outils [T] de la vue 3D, y compris pour les F-Curves. Accessible via le
champ de recherche (touche [Espace]) en y saisissant simplify curves ou
simplify fcurves.

Add Mesh
ANT Landscape : permet de générer une primitive de paysage, à partir du
menu Add>Mesh ou de la combinaison [Maj]+[A]. Le type de paysage et
ses paramètres sont réglages dans l’étagère à outils [T].

BoltFactory : permet de générer des primitives de boulons et de vis, à
partir du menu Add>Mesh ou de la combinaison [Maj]+[A]. Le type de
visserie et ses paramètres sont réglages dans l’étagère à outils [T].

Extra Objects : met à disposition de nouvelles primitives complexes : des
fonctions de surface 3D, des engrenages, des pierres précieuses, des
tores, et d’autres encore. Toutes ces primitives sont disponibles via le
menu Add>Mesh>Extras ou la combinaison [Maj]+[A].

Pipe Joints : permet de générer des connexions de tuyauteries (jusqu’à 5
d’entre elles), à partir du menu Add>Mesh ou de la combinaison [Maj]+[A].
Les paramètres de la jonction sont réglages dans l’étagère à outils [T].

Regular Solids : permet de générer des polyèdres réguliers, à partir du
menu Add>Mesh ou de la combinaison [Maj]+[A]. Les paramètres sont
accessibles dans l’étagère à outils [T].

Animation
AnimAll : permet l’animation des données de maillage (Verts, VCols,
VGroups, Uvs) au travers du panneau AnimAll de l’étagère à outils [T].

Corrective shape keys : en ajoutant un premier objet comme forme d’un
second objet, cet add-on facilite la création de formes clés (Shape Keys,
voir le chapitre 7 « Techniques d’animation fondamentales ») qui corrigent
les volumes déformés en fonction des poses et des modificateurs en place.

Motion Capture Tools : un jeu d’outils variés pour travailler avec des don-
nées d’animation motion capture.
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Compositing
Film Reponse Curves : applique un film response preset au nœud RGB Curves.
Non documenté.

Development
API Navigator : permet d’explorer l’API Python au-travers de l’interface
utilisateur. S’active dans l’éditeur Text et le menu View>Properties.

Icons : permet de cliquer sur une icône pour afficher son nom et le copier
dans le presse-papier. S’active dans l’éditeur Text et le menu View>Properties.

Game Engine
Save As Game Engine Runtime : permet de packager un fichier .blend avec
le BlenderPlayer de façon à ce qu’un jeu développé avec Blender soit
directement exécutable.

Import et Import-Export
Un grand nombre de formats d’images, de fichiers et de géométries sont
supportés :
• 3D-Coat Applink ;
• Acclaim Motion Capture Files (.asf, .amc) ;
• Atomic Nlender – PDB ;
• Autodesk 3DS format ;
• Autodesk FBS format ;
• BioVision Motion Capture (BVH) format ;
• C3D Graphics Lab Motion Capture file (.c3d) ;
• DirectX Model Format (.x) ;
• Export Autocad DXF Format (.dxf) ;
• Export Camera Animation ;
• Export Pointcache Format (.pc2) ;
• Export Unreal Engine Format (.psk/.psa) ;
• Export HiRISE DTM from PDS IMG ;
• Import Autocad DXF Format (.dxf) ;
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• Import GIMP Image to Scene (.xcf/.xjt) ;
• Import Images as Planes ;
• Import LightWave Objects ;
• Import Unreal Skeleton Mesh (.psk)/Animation Set (.psa) ;
• Import MakeHuman (.mhx) ;
• MilkShape3D MS3D format (.ms3d) ;
• NewTek MDD format ; Nuke Animation Format (.chan) ;
• Quake MAP format ;
• Raw mesh format (.raw) ;
• STL format ;
• Scalable Vector Graphics (SVG) 1.1 format ;
• Stanford PLY format ;
• UV Layout ;
• Wavefront OBJ format ;
• Web3D X3D/VRML2 format.

Material
Material Utils : affiche un menu relatif aux outils matériaux (assigner,
sélectionner, etc.) directement dans la vue 3D. Malheureusement cet
add-on est bogué et ne fonctionne pas lorsque le moteur de rendu est
Cycles. À éviter pour le moment.

Mesh
Bsurfaces GPL Edition : il s’agit d’un outil de modélisation et de retopo-
logie qui combine l’utilisation de tracé à main levé, de courbes de Bézier
et d’arêtes pour générer des surfaces polygonales, accélérant substantiel-
lement le procédé de modélisation. Les différentes options peuvent être
modifiées interactivement, permettant d’observer en temps réel com-
ment ils affectent la surface résultante. L’outil s’active dans l’étagère à
outils [T] de la vue 3D, en mode Edit.

F2 : permet d’étendre les fonctionnalités de création de facettes, à partir
d’un simple sommet ou d’une simple arête, en utilisant la touche [F] tradi-
tionnellement dévolue à l’opération de création de facettes, en mode Edit.

Inset Polygon : cet add-on permet d’intercaler des facettes, à la manière de la
fonction Inset décrite dans le chapitre 4 « Techniques de modélisation ».
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LoopTools : une boîte à outils pour aider à la modélisation. Sélectionnez
une arête de boucles puis utilisez l’un des outils présents dans l’étagère à
outils [T] ou faites apparaître un menu dédié grâce à la touche [W] : créez
des ponts entre des groupes de facettes ou des boucles (closes d’arêtes),
réarrangez une boucle d’arêtes en cercle, lissez les boucles d’arêtes situées
de part et d’autre d’une boucle sélectionnée, aplatissez un ensemble de
facettes sur le même plan, étirez une sélection pour correspondre à une
marque de crayon gras (Grease Pencil), connectez des ensembles de bou-
cles entre elles en une seule fois, relaxez les maillage dont les boucles
présentent des angles trop vifs, espacez de façon régulière des sommets
le long d’une boucle d’arêtes.

Relax : permet de relâcher le maillage de façon à ce qu’il soit distribué de
façon plus égale, tout en préservant les volumes, en utilisant l’entrée
appropriée du menu appelé par la touche [W].

Object
Add Chain : permet de faciliter la création d’objets formant des chaînes de
maillons, via le menu Add>Mesh>Add Chain ou la combinaison [Maj]+[A].

Animated Render Baker : permet de réaliser un baking pour chaque frame
d’une animation et sauve le résultat avec un nom spécifique à la frame
concernée, comme par exemple image0001.png. Pratique pour créer des
cartes normales animées, par exemple, à partir d’un maillage dont la sur-
face est elle-même animée. Les options apparaissent dans le panneau
Bake du menu Scene.

Cell Fracture : permet de réaliser d’intéressants effets spéciaux, en brisant
des objets de bien des différentes façons, avec de nombreux paramètres
et options pour vous permettre d’atteindre le résultat désiré. Un bouton
Cell Fracture fait son apparition dans l’étagère à outils [T] pour appeler les
nombreux paramètres.

Cloud Generator : permet la création de nuages volumétriques grâce au
panneau Cloud Generator de l’étagère à outils [T]. Fonctionne unique-
ment avec le moteur Blender Render. 

Grease Scatter Objects : permet de disperser un groupe d’objets à la sur-
face du maillage actif en utilisant des lignes tracées avec le crayon gras
(Grease Pencil), via le menu Add>Mesh ou la combinaison [Maj]+[A].
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Paint
Paint Palettes : dans n’importe quel mode de peinture (Weight, Texture,
Image, Vertex), permet d’afficher des palettes dans le panneau de l’étagère
à outils [T]. Pour les modes Weight et Vertex, les 11 valeurs possibles sont
directement accessibles, tandis que pour les modes Texture et Image,
l’add-on permet de lire et écrire des palettes au format de Gimp.

Texture Paint Layer Manager : permet de mettre en place un système de
calques pour le mode Texture paint, prenant en compte la transparence,
sans avoir à passer par tout un systèmes de textures UV empilées. L’affi-
chage des contrôles de cet add-on passe à la fois par l’étagère à outils [T]
et le panneau numérique [N] : les deux devront être affichés pour un
usage optimal.

Render
Copy Settings : permet de copier des réglages de rendu d’une scène à
l’autre du même fichier .blend, en ajoutant un panneau Copy Settings
dans le menu Render. Des options permettent de contrôler les paramè-
tres à copier, ainsi que la ou les scènes de destination.

Cycles Render Engine : activé par défaut, permet de réaliser le rendu en
utilisant le moteur Cycles Render à la place de Blender Render.

Light Fields Tools : permet d’effectuer le rendu de champs de lumière (light
fields) en plaçant des spots uniformément distribués sur une grille qui
projettent une texture et d’y associer une caméra par paire de spots. Utile
pour la recherche sur les méthodes d’illumination, de rendu, pour l’affi-
chage stéréoscopique, la dispersion lumineuse et d’autres sujets voisins.

Network Renderer : permet de distribuer le rendu sur plusieurs machines
disposant du logiciel Blender, en définissant une machine « maître » et
d’autres machines « esclaves ». Le baking (simulations physiques, parti-
cules, modificateurs) est pris en charge.

POV-Ray 3.7 : intégration à Blender du moteur de rendu POV-Ray 3.7.
Attention, car tant le moteur de rendu que ce script sont en version bêta.

Renderfarm.fi : permet d’ajouter le service de ferme de rendu
renderfarm.fi aux moteurs de rendu possibles. Nécessite un compte
avec identifiant et mot de passe.
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Rigging
Rigify : aide à automatiser la création d’armatures pour vos personnages,
vous permettant de construire une armature bout par bout en ajoutant
des armatures de bras, de jambes, de colonne vertébrale, de doigts, etc.
Si cet add-on permet la création des os et des contrôles d’animation, le
processus de skinning (voir le chapitre 8 « Techniques avancées
d’animation ») doit malgré tout être mis en œuvre par l’utilisateur.

System
Demo Mode : permet de sélectionner plusieurs fichiers .blend et réaliser
une boucle entre eux, afin de faciliter les démonstrations ou les présenta-
tions. La démonstration se paramètre via le menu général File puis en
choisissant Demo Mode (Setup).

Object Property Chart : permet d’éditer des propriétés sélectionnées arbi-
trairement entre des objets de même type, permettant ainsi de copier-
coller celles de votre choix (le nom de chaque propriété est indiqué dans
la bulle d’aide d’un paramètre de l’interface) d’un objet à l’autre.

Scene Information : permet d’afficher, dans le panneau Blend Info du menu
Scene, des informations statistiques sur votre fichier .blend.

UV
Bake UV-Textures to Vertex Colors : permet de convertir les couleurs de la
texture UV courante en un calque Vertex Color. Ne fonctionne qu’avec
une texture de type Image (les textures procédurales ne sont pas prises en
charge) et nécessite, pour une bonne transposition des couleurs, d’avoir
un maillage suffisamment finement subdivisé pour obtenir une résolu-
tion suffisante de l’image en mode Vertex Paint.
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Vous trouverez ci-après les indices de réfraction pour des matériaux cou-
rants. Cet indice est aussi bien utile au moteur de rendu interne de
Blender qu’au nouveau moteur de rendu Cycles, ainsi qu’à tous les autres
moteurs de rendu externes pouvant travailler en synergie avec Blender.

Les valeurs les plus communément admises sont les suivantes. Notez
que ces valeurs peuvent varier d’une documentation non scientifique à
l’autre.
• Acétone 1.36
• Air 1.00029
• Alcool 1.329
• Alcool d’éthylène 1.36
• Ambre 1.54
• Barrium borosilicate 1.554
• Cristal 2.00
• Cristal iodé 3.34
• Diamant 2.417
• Dioxyde de carbone liquide 1.20
• Eau 1.333
• Émeraude 1.57
• Glace 3.309
• Lapis-lazuli 1.61
• Opaline 1.44 - 1.46
• Oxyde de chrome 2.705
• Oxyde de cuivre 2.705
• Plexiglas 1.51
• Plastique 1.2

CLes indices de réfraction
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• Porcelaine 1.504
• Quartz 11.644
• Rubis 1.77
• Saphir 1.77
• Sel 1.644
• Solution de sucre (30 %) 1.38
• Solution de sucre (80 %) 1.49
• Topaze 1.61
• Vide 1.000 
• Verre 1.5
• Verre blindé 1.89
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Sites informatifs
B http://www.blender.org

Il s’agit du site officiel, en anglais, de Blender. Outre des nouvelles généri-
ques sur Blender, il propose de télécharger les dernières versions, offre un
catalogue de didacticiels à découvrir, une galerie époustouflante à visiter
ainsi que des liens vers de nombreuses communautés ou sites d’amateurs.
Il héberge aussi les forums consacrés aux développeurs de Blender.
B http://www.blendernation.com

Ce site en anglais a la vaste ambition d’offrir quotidiennement des nou-
velles fraîches de l’univers Blender. Maintenu par l’ancien responsable de
la communauté de Blender, il est une référence absolue pour tous les
amateurs de Blender en quête de nouveautés, d’articles ou de nouvelles
intéressantes, mais qui n’ont pas le temps de les glaner eux-mêmes.
B http://cgcookie.com/blender/

Blender Cookie regroupe un ensemble de tutoriels destinés à l’apprentissage
de Blender, sur différents supports ; au format Web, tutoriels vidéo, DVD
de formation ainsi que quantités de ressources utiles au débutant comme au
chevronné. Ce site offre des services et des produits commerciaux.
B http://www.blendernetwork.org/

Blender Network est un réseau animé par la Fondation Blender et à des-
tination des professionnels, des studios et des instituts éducationnels. Il
est possible d’y créer sa page de présentation et de se connecter aux
autres membres du réseau.

DRessources web
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Communautés
Blender a une communauté à la fois riche, vivante et passionnée.
B http://www.blenderartists.org

Il s’agit du site officiel de la communauté anglophone des utilisateurs de
Blender. Il abrite un forum où tous les utilisateurs de Blender se retrou-
vent, ainsi qu’une liste de communautés locales (les Blender Meetups)
pour trouver d’autres utilisateurs près de chez vous. Les forums héber-
gent également une section pour offrir ses services de free-lance ou pour
prendre connaissance d’offres d’emplois.
B http://www.linuxgraphic.org

Il s’agit d’un site français consacré à la promotion des logiciels d’infogra-
phie libres (2D, 3D, vectoriel). Outre des nouvelles fraîches quant à
l’actualité infographique libre, il propose une collection impressionnante
de didacticiels pour un grand nombre de logiciels libres, des ressources,
des liens, ainsi que des forums accueillants où il fait bon flâner.
B http://blenderclan.tuxfamily.org/html/

Ce site est l’un des piliers de la communauté française des utilisateurs de
Blender. Véritable portail consacré à Blender, il offre des nouvelles fraî-
ches sur l’actualité de ce logiciel. Il héberge également des forums très
vivants.

Ressources et documentation
B http://wiki.blender.org/

La documentation officielle est hébergée sur ce wiki. D’importants
efforts sont déployés pour maintenir cette documentation à jour malgré
le développement intensif et très rapide de Blender. Le wiki est ouvert à
toutes les bonnes volontés capables et désireuses d’aider les auteurs à
tenir le rythme des nouveautés.
B http://www.blendswap.com/

Ce site héberge des bibliothèques entières de modèles 3D faits pour
Blender par des utilisateurs de Blender. Les catégories des modèles sont
extrêmement variées : accessoires, animaux, électroménager, architecture,
personnages, vêtements, électronique, nourriture, ameublement, paysages,
Lego, modèles Low-Poly (basse résolution), objets divers, instruments de
musique, plantes, scènes, science-fiction, outils, véhicules, armes… Du
point de vue des ressources, il est également possible de télécharger : ani-
mations, thèmes pour Blender, brosses de sculpture, matériaux pour Cycles
Render, matériaux pour Blender Render, motifs répétitifs, compositions de
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nœuds, armatures prêtes à l’emploi, simulations, systèmes de particules,
ainsi que textures. Composante commerciale.
B http://www.katorlegaz.com

Entre autres ressources, ce site anglophone vieillissant continue à
héberger une impressionnante collection de modèles prêts à l’emploi et
couvrant de très nombreux sujets : aéronautique, animaux, accessoires de
cuisine, éléments architecturaux, automobiles, charrettes, personnages,
informatique, effets spéciaux, électronique, fantastique, nourriture,
mobilier, vaisselle, insectes, décors, éclairages, plantes, mobilier de rue
ou de parc, scènes, science-fiction (Star Wars, Start Trek...), outils,
camions, motos, armes et d’autres catégories encore.




